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Introduction 
GEOPAK is a comprehensive software package that was adopted by T.D.O.T. in 2000 
for use by all personnel to avoid duplication of effort and to provide a more streamlined 
data flow between divisions from start to finish of a roadway project. 

Using GEOPAK will help ensure consistency and accuracy of design work and generate 
a significant time savings in the overall effort of producing construction plans. 

The dialog views, etc. in this course guide reflect GEOPAK V8i (SELECT Series 2), 
version 08.11.07.615.  

Standard GEOPAK Road Project Filenames 

job###.gpk Binary file which contains all coordinate geometry.  

This includes topo features, DTM points, horizontal & vertical 
alignments as well as property parcels. Only one file will be created 
for each project. T.D.O.T. Survey personnel initially create this file 
and add the existing data to it. Design adds proposed information 
and passes it on to Construction and R.O.W. personnel for 
completion of the project. 

 The "###" is the only variable in this filename.  It represents a job 
number (up to 3 alphanumeric characters) unique to a project. The 
first number corresponds to the T.D.O.T. Region.  

filename.prj Binary file resulting from the creation of a new project. 

filename.tin Binary file containing a triangulated surface also known as the digital 
terrain model (DTM). 

filename ###.ioc ASCII input file for loading data during a COGO session. 

 "###" represents the job number and "oc" is the operator code 
(users initials). Filename characters are limited to 5 characters plus 
the 3 job number character designation. 

filename###.ooc ASCII output file created by GEOPAK during a COGO session. 

 Variables are the same as those defined for COGO input files. 

filename.inp  ASCII input file for running some GEOPAK processes such as 
superelevation.  Name is user defined with an .inp extension.  

filename.dat ASCII or Binary file that contains string and point information to be 
used for digital terrain model creation. 



GEOPAK Road Project File Structure  
(Class project SR95 used as Example)  

C:\      (drive) 
   └── Projects\    (main folder for all projects) 
      └─ Roane\   (county folder) 
       └─ SR95PoplarCr\  (roadway project folder) 
        └─ SR95.prj  (project file) 
        └─ *.dgn                  (graphics files) 
        └─ job101.gpk  (coordinate geometry database) 
        └─ *.tin                   (digital terrain model files) 
        └─*101 .i**                   (COGO input files) 
        └─*101 .o**                  (COGO output files) 
        └─* .inp                   (input files) 
        └─ projdbs\  (project manager folder) 
         └─ Joe\  (user folder) 
                └─ user.info (user information file) 
                └─ SR95.000 (3D Model runs) 
                └─ SR95.003 (Proposed Cross Section runs) 
                └─ SR95.004 (Earthwork runs) 
                └─ SR95.005 (Cross Section Sheet runs) 
                └─ SR95.008 (Working Alignment runs) 
                └─ SR95.009 (Existing Ground Profile runs) 
                └─ SR95.011 (Draw Patterns runs) 
                └─ SR95.012 (Superelevation runs) 
                └─ SR95.014 (Plan/Profile Sheet runs) 
                └─ SR95.b14 (Plan/Profile Sheet runs) 
                └─ SR95.00a (Vertical Alignment runs) 
                └─ SR95.00c (Limits of Construction runs) 
                └─ SR95.00d (Existing Ground DTM runs) 
                └─ SR95.00e (Existing Cross Section runs) 

When making backup copies of project data do not forget to copy the GEOPAK runs 
which are found under the users’ folder in the projdbs folder. All runs use the GEOPAK 
project name followed by the run extension which depends on the type of run. 
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1. User Preferences 
This exercise is to familiarize you with GEOPAK’s User Preferences which control 
the output format of data produced when using GEOPAK. 

When you set up a Design Road Project as we will do in the next exercise, it stores 
its own set of “user preferences” which are reloaded each time the project is loaded. 

NOTE:  
The real advantage of accessing User Preferences as shown in this exercise is “on 
the fly” settings. You can temporarily make settings to see more decimals, etc. in 
order to check something, knowing that whenever you reload your project the 
standard user preferences stored with the project will replace those temporary 
settings. 

1a. Defining Design User Preferences 
1) Open the MicroStation file:  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

NOTE:  
This path above is to be used for this class only. The project folder name is based 
on the project limits for this roadway. This project is on S.R. 95 in Roane County and 
its limits are from Poplar Cr. To Westover Drive. It is recommended that the project 
folder name include the roadway name and the beginning location of its limits. In the 
case of smaller projects such as bridge or intersection projects, you might use the 
creek or river name, the intersecting roadway name or a log mile with the mainline 
roadway name to set a project folder name.  
 
The project folder name that you choose to store your project in should follow this 
same basic format to avoid conflicts with other projects on the same roadway in the 
same county.  

2) Access the GEOPAK User Preferences dialog from the MicroStation menu bar.  
Applications → GEOPAK → Road → User Preferences. 
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3) The User Preferences dialog should appear as shown. Check the standard 
settings for formats and output accuracy.   

  

4) Press the Feature Preferences button and set the Plot Scale to 50 as shown. 
The SMD file should be set automatically. Click on the Apply Best Match 
Feature option. 

 

Press OK to save the settings. 
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5) Press the COGO Preferences button and review the settings available there. In 
our standard workflow we do not set special directories for COGO files. Instead, we 
set a project working directory where all project files go. 

 

Press Cancel to exit without making any changes. 

6) Click on the explorer button to the right of the Working Directory keyin field. 
Navigate to the project working directory as shown and click OK to set. 
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7) Now that all settings are made, the User Preferences dialog should appear as 
shown. 

 

On the GEOPAK User Preferences dialog, press OK to exit and save settings. 
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2. Project Manager 
This exercise introduces GEOPAK Road’s Project Manager. This tool organizes 
project work with users and their associated runs. Runs are a way of saving how a 
particular function was used or setup previously which can save the user valuable 
time. 

Project Manager also provides a workflow dialog making it easy for the user to find 
tools/functions which are used most often. 

2a. Introduction & Set Up 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

2) Click the Civil Workflows option from the Task menu. This will make the basic 
Road Tools readily accessible.in the Main Task options at the top. 

 

Civil Workflows makes most tools from Geopak Suite available in the Task menu. 
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3) Access Project Manager using the Project Manager icon from the main tasks.  

 

4) From the right side of the Project Manager dialog, in the Directories list box, ensure 
that the project directory is set to 

C:\Projects\Roane\SR95PoplarCr 

 

Select the Projects → New drop down and set up the new project as specified. 
Use the Select buttons to set the Working Directory and Job Number: 

Project name: SR95 

Working Directory: C:\Projects\Roane\SR95PoplarCr 

Job Number: 101 (The first number is the TDOT Region #, the remaining 
characters are assigned per project by Survey personnel). 

Project Description: SR95 From Poplar CK to Westover Dr. 

NOTE: 
Survey personnel initially sets up the GPK file (indicated by the Job Number), stores 
existing features for projects and then gives it to Design with the completed survey. 
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Design personnel, in turn, adds proposed features and passes it on to R.O.W. & 
Construction personnel for their use in completing the project. 
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The Create New Project dialog should now appear as shown. 

 

5) Click Preferences on the Create New Project dialog. Since we set up our 
standard user preferences in the previous exercise, the settings should appear as 
shown. These are the project preferences which will be loaded whenever the project 
is opened. 

 

Press OK. 
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6) After exiting the Preferences dialog, you will return to the Create New Project 
dialog, press the OK button.  

7) The main Project Manager dialog is now displayed, and the project has been 
created and ready to be accessed.  To access the project select the project by single 
clicking on the name of the project in the dialog.  The project is highlighted as shown 
in the dialog with all pertinent information displayed.  

 

Press OK to open the project and invoke the Project Users dialog. 
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8) Create a new user by selecting Users → New from the Project Users menu 
bar. Complete the New User dialog with your name and operator code (your initials) 
as shown. 

      

After populating the dialog press OK. When prompted to define a password for this 
user, press No. 

 

NOTE:  
The operator code is used by COGO with input and output files. Those characters 
control what input files are included for opening or processing and are used when 
assigning names for input or output files. 
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9) Now, we are back at the Project Users dialog. Double click the user name or 
select it and click OK to move on. 

 

10) You will now see the main Project Manager workflow dialog. From here, we can 
access many of the GEOPAK functions which we will use. 
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11) Click on the Remember option to set up Project Manager to remember our 
Project and User. 

 

NOTE:  
In normal workflows you must be careful with the “Remember” options. If you have 
more than one project active at one time, you will have to Un-Check both Project 
and User before moving to another project.  
 
This must be done to ensure that files are placed or looked for in the proper folders 
to avoid mixing project data. Of course another alternative is to not use the 
Remember options if you have more than one project. That way you can move to the 
project you need to be in each time you invoke Project Manager. 
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2b. Working Alignment – Create 
Before leaving this exercise, let’s go ahead and begin to set the stage for further 
design via the Project Manager by defining the Working Alignment. To do 
this, we’ll need to use the Select and Define buttons on the Project Manager 
workflow dialog. 

1) Press the Select button to create a new Working Alignment. The Working 
Alignment is the active roadway that we are about to design. In the Select 
Working Alignment dialog create a new run by clicking the drop down option 
Run → New. 

 

NOTE:  
GEOPAK organizes many functions with “Runs”. Each time you use many of 
GEOPAK’s tools or functions you will be asked to create a run. Runs store the 
entries/settings made in a tool so that you can return later to re-run a particular 
function or even copy it in order to set it up to run a little differently. 

Working Alignment set ups or runs are actually used by other runs. The working 
alignment will automatically fill in other runs with pertinent data associated with a 
given roadway thus saving much time and effort for the user. 
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2) Create a new Working Alignment run called “SR95” and a Description for the Run 
‘mainline’ as shown below and press OK. 

 

3) After creating the run select the run by highlighting it in the dialog and pressing OK. 

4) You will now return to the main Workflow dialog.  Press the Define button to 
access the Working Alignment Definition dialog. 

5) Select the Plan View item in the list box and define the Design File as 

C:\Projects\Roane\ROSR95Proposed.dgn. Click the Browse button  
to set this file. 

 

6) Press OK to exit and save settings in the Working Alignment Definition dialog. 
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7) Back on the main Project Manager dialog click on the Working Alignment 
Influence Runs option. With this clicked on, data defined in the working alignment 
will automatically fill in runs when they are created or opened. 

 

8) Exit Project Manager, select File → Exit. 

 



Exercise 3 

GEOPAK V8i (SELECT Series 2) Digital Terrain Models   3-1 

3. Digital Terrain Models 
In the normal project flow, the existing ground digital terrain model (*.TIN) file is 
created by Survey personnel.  

In this exercise, we will demonstrate some of the tools which are available to pull 
information from those surfaces.  

3a. Accessing DTM Tools 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Contours.dgn 

Access Project Manager.  It should automatically access the Road workflow 
dialog since we “remembered” the options in Exercise 2. 

2) Select the icon Existing Ground from the Project Manager workflow dialog. 

3) Create a new run named ground. 
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4) After creating the run, select the run by highlighting the name of the run in the dialog 
list box and press OK. 

 

This will invoke the DTM tool frame.   

 

If you prefer a drop down menu click on the menu icon at far left of the tool frame. 

 

5) You can set the Project Manager workflow dialog to automatically sink when a 
tool is chosen by setting the drop down option Options → Auto Sink.  

 

The small button on the upper right of the Project Manager workflow dialog will 
minimize it to a bar   
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Use one of these options to help keep your workspace clear. 

3b. Display DTM Features 
1) Select the Load Features icon from the tool frame to invoke the following dialog. 

 

 

2) Use the File → Open drop down to open the preference file tdotEXIST.lpf from 
the C:\Users\Public\Geopak Standards directory. This will set the 
symbologies to TDOT standards for existing digital terrain models. 

NOTE:  
When working with proposed surfaces use tdotPROP.lpf for graphic displays. 

3) Set the Load File option to TIN. 

4) Select the TIN file ‘RO095-01.tin’ by clicking the navigator  button and 
going to the project directory C:\Projects\Roane\SR95PoplarCr. 

5) Select the Triangles Feature by highlighting in the list box at the bottom. Notice 
that initially the display is set to OFF. You can control the display of an item three 
ways: 

• Use the “light bulb” icons to the right of the dialog  
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• Double-click on an item 
• Use the “display” toggle in the lower right corner of the dialog 

Set the Triangles display to ON. 
 
6) Note the display symbology for the Triangles as indicated in the symbology review 

box in the lower portion of the dialog.  Due to the length of the level name, it will 
usually not appear completely in the main item list. If you float your cursor over the 
symbology review box, you can see the settings in the pop up info. 

 

If you wish to change the symbology for an item, simply double click in the 
symbology review box to open the Set Feature dialog 

 

Click Cancel to close this dialog without making any changes. 

7) Make sure the display of the Tin Hull (the boundary of the surface model) is ON.  
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8) Select the Contours feature and make sure the display is ON. 

9) Complete the bottom of the dialog as indicated below. To complete the Minimum 
and Maximum Z, Press the Read button, which will review the active TIN file 
and determine these values. 

Once you read the limits of any surface, you can determine what minor and major 
intervals might work best. For flatter surfaces smaller intervals might be required or 
in the case of larger differences between the minimum and maximum Z elevations 
larger intervals might be needed. 

 

Notice that Major and Minor contour lines and text are controlled separately. 
Check to make sure all are ON except for Minor Label. 

10) Set the Load option to Extent, deactivate the Display Only toggle and 
activate the Graphic Group toggle to write the graphics to this file as a graphic 
group. 
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11) Press the Load button to initiate the process. Fit the view and check out the 
resulting graphics. Use MicroStation's Level Display dialog to turn levels on and off 
in order to see the different features. 

Triangles  SURVEY - DTM GRAPHICS - Triangles 

TIN Hull SURVEY - DTM GRAPHICS - Boundary Line 

Major Contours SURVEY - CONTOURS - Index with Text 

Minor Contours SURVEY - CONTOURS - Intermediate with optional Text 

 
12) Turn off the level display for the triangles so you will be ready for the next exercise. 

13) Close the Load DTM Features dialog and click Yes to Save Settings when 
prompted. 
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3c. Analysis Tools 
We will review several analysis tools in the following exercises.  These include the 
height/slope tool, drainage tools and the profile tool. 

Height/Slope Tool 
1) Select the Height/Slope icon from the DTM tool frame to invoke the following 

dialog. 

 

 

2) Make sure Mode is set to Elevation and Display Only is clicked on. Under 
Options, activate the Show Contour and Show Flow Arrow toggles. The 
color may be altered to your choice of colors from the color picker buttons to the 
right of the Options on the Height dialog. The level, weight and style of the contour 
line and arrow are controlled by the active MicroStation settings. 
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3) Click the Start button and scan the surface model with the cursor to display the 
values for xyz and the slope on the model at the cursor point. 

 

4) To actually display these graphics in the file, click off the Display Only option 
and data point any place you want graphics placed. 

5) Close the Height/Slope dialog. 

Drainage Tools 
1) Click on the Height/Slope tool holding the mouse button down and drag the 

pointer away to pop up all of the Analysis tools. Select the Open as Toolbox 
option at the bottom to access the Analysis toolbox.  
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2) Select the Drainage Tools icon from the Analysis tool box to invoke the dialog 
depicted below.  

 

 

3) Ensure that all graphic elements are Fit into View 1 and turn off contour levels. 

4) Select the Flow Arrows tool as shown and set the Arrow Size to 5. Click on 
Set Graphic Group. 
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5) Next, double-click on the symbology review box to open the Set Feature 
dialog. Set the symbology as shown and press OK. 

 

 

 

The level name is SURVEY - DRAINAGE - Area Shapes Text. 

6) Back on the main dialog, press Apply. The drainage flow arrows will be drawn into 
the design file.  

 

7) Next, turn off level SURVEY - DRAINAGE - Area Shapes Text (flow arrows) 
and zoom in on any portion of the dtm. 

  

Symbology review box 
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8) From the Drainage Tools dialog, select the Downstream Trace tool as shown. 
The Downstream Trace Tool delineates the flow path downstream from any given 
point in the TIN.  

Set the Display Only toggle to ON and the Minimum Low Point Depth to 1. 

 

9) Press Apply and then data point somewhere on the dtm. The flow path 
downstream should be displayed in the design file. You may enter several data 
points consecutively, then reset to exit. You may wish to turn on the contours to get 
a feel for the results you are getting. 
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10) Take some time to try some of the other Drainage Tools. 

11) Dismiss the Drainage Tools dialog. 

Profile Tool 
This tool is useful for quick checks of profiles across surfaces but for permanent 
displays we recommend use of the Draw Profile or Existing Ground Profile tools. 
They will be shown in later exercises. 

1) Select the Profile icon from the Analysis tool box to invoke the following dialog. 

 

 

2) Under the Object Selection  icon on the left identify your surface model 
(TIN File) which will be used to generate a profile, and identify the symbology for 
your profile. 

Select the TIN file ‘RO095-01.tin’ by clicking the “browser” button and going to 
the project directory C:\Projects\Roane\SR95PoplarCr 
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NOTE:  
This tool will process multiple surfaces at one time so if proposed surfaces have 
been created they could be cut at the same time. 

3) Double-click on the symbology review box on the right of the “browser” (button 
at the bottom of the dialog) to open the Set Feature dialog. Set the symbology 
representing the ground surface profile. Make settings as shown and press OK. 

 

The level name is SURVEY - PROFILE - Ground Line with Text. 

4) Press the Add icon  to add the feature to the collection box. 
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5) Select the Profile icon.  

6) Press the  Place Element button to cut your actual profile at any desired area by 
just placing two data points (i.e. a line) or a series of data points (i.e. a line-string) 
across your surface model at any location. 

 

7) You can use the Preferences icon  to set up a grid for your profile if 
desired. 
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Click on the Profile icon and see your profile with the grid parameters that have 
been set. 

 

If not happy with your grid settings, go back to Preferences to adjust. You can use 
the Place Profile icon at the far right to place your profile graphics in MicroStation 
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8) If you think you might use this set up again later you can save all of your settings by 
going to the drop down option Files → Save. 

 

9) Close the Profile dialog and the DTM and Analysis tool frames. 
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3d. Working Alignment – Define DTM 
We now have more information to set in the Working Alignment. To do this, we’ll 
need to use the working alignment Define button on the Project Manager workflow 
dialog.  The Project Manager workflow dialog should still be active. Re-access the 
dialog by selecting Window → Road Project: sr95.prj from the MicroStation 
menu bar or by clicking on the Project Manager icon. 

1) Press the Define button to access the Working Alignment Definition dialog. 

2) Select the DTM item in the list box and complete the DTM definitions as shown 
below: 

 

We will discuss the use of the Port Viewer tool in a later exercise. 

3) Press OK to exit the Working Alignment Definition dialog and to save our new 
settings. 

4) Exit Project Manager using the File → Exit drop-down option. 
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4. Coordinate Geometry 
In the normal workflow, Survey personnel develop preliminary centerlines based on 
the project’s advanced planning report (APR). When the survey data is 
passed on to Design, we have to review those preliminary centerlines to determine if 
they can be used for the proposed design of the roadway. Several issues must be 
addressed including: 

• Standard Design Specifications – do curves meet design specs 
• Encroachment – can a vertical alignment be developed which when used with 

the centerline and typical section does not encroach excessively on 
properties, historical or archeological sites, wetlands, etc. 

• Constructability issues – If traffic is to be maintained on existing roads can 
the roadway be built as designed while maintaining traffic flow. 

With this in mind this exercise takes a preliminary centerline as it might come from 
Survey and goes through the processes Design might use to alter that centerline 
chain to meet the requirements encountered through the design process. 

As we work with this proposed centerline, we will look at different methods that 
GEOPAK provides to store coordinate geometry including basic COGO and 
Horizontal Alignment tools. 

4a. Basic COGO 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager. 

2) Select the Coordinate Geometry icon from the Project Manager workflow 
dialog. 
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3) The Coordinate Geometry dialog opens as shown below. 

 

This dialog is completely re-sizable, so you can re-size and position it where you’re 
most comfortable. 
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COGO Interface 
In the next few steps, we’ll take some time to familiarize ourselves with the COGO 
interface. 

4) All basic COGO commands are available through the drop down options from the 
COGO menu bar. These include the creation of objects such as points, curves & 
chains as well tools to report information on those objects.  

These tools can also be activated via the icons at the top. The icons shown at the 
top are customizable by the user. 

 
Click on the drop down option  
View → Icons → Customize This Group. The following dialog is opened. 

 

Scroll through the list and make sure the following are clicked on. 

• Input File Utility  (under File) 

• Equate  (under Element/Point) 

• Copy  (under Element/Curve) 

• Station  (under Element/Chain) 
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• Store From Elements  (under Element/Chain) 

• Store Transition Chain  (under Element/Chain) 

• Elevation  (under Element/Profile) 

• Navigator  (under Tools) 

• Locate Traverse  (under Tools) 

In upcoming exercises, we will be using these tools. 

5) On the Coordinate Geometry dialog face there are options for decimal values. 
These are the same controls we accessed previously through User Preferences.  

By default, the Distance Decimal and Angle Decimal Second options are turned on. 
We will not be using those in these exercises, so go to View → Format and turn 
them off.  
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It should be noted that these decimal values should only be changed 
temporarily from the project default values since they will affect graphical 
displays.  

Occasionally, the Distance Decimal and Station Decimal options are handy 
to have out when checking values that were previously rounded off to the standard 2 
decimal places.  

6) The first tool we want to look at is Navigator. This tool will allow you to access any 
object stored in the project’s GPK file. Click on the Navigator icon to open it up. 

 

 

Click on the Element option list to look at other object types stored in the GPK file. 

The Navigator is re-sizable and various types of data information are available 
depending on which Element option is active.  

 

NOTE:  
For this class, we are using a stripped down version of the GPK file which only 
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contains the preliminary centerline. Normally this file would also include all other 
features located by Survey (topo, dtm, parcels). 

7) Click on the Element option button and set it to Chain. 

8) Click on preliminary chain SR95 and then click on the Print\Describe 
Element icon (2nd from right). 

 

9) In the COGO output area the coordinate geometry output of the chain is printed. 
Review the objects which make up this chain. 
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10) From our review we can see chain SR95 consists of : 

Point S101 
Spiral Curve SC102  (Spiral SC102B, Curve SC102, Spiral SC102A) 
Simple Curve SC103 
Point S104  

NOTE:  
Since all of these objects were stored by Survey, they all include the prefix letter S. 
Any objects which we store should begin with the letter D for Design that way we 
can tell who stored any given object in the GPK file. 

Spirals always include the ending letters, B (for Back) or A (for Ahead). 

Re-name Preliminary Centerline Chain 
It has been determined that this project should include the Poplar Creek drainage 
structure so we need to extend the centerline back.  

Since we need to keep a copy of the original preliminary centerline for reference and 
also must keep the proposed centerline name as SR95 to maintain the intelligence 
on smart labels placed for present R.O.W. flags, we will first save the preliminary 
centerline under another name and then revise the original for the new proposed 
centerline. 
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11) In the COGO dialog, make sure the visualization options are set to Disable 
Visualization & OFF (Feature). We do not want the preliminary chain to be 
visualized (graphically displayed). 

 

12) Click on the Redefine option (located left of the “Disable Visualization” option). 
Open up COGO Navigator to Chain and double click on the preliminary 
centerline chain SR95. 

In the Store Chain dialog change the name to SR95PRELIMINARY and click 
on Store Chain. COGO element names can be up to 15 characters long. 

 

13) Back in the Navigator, check to make sure you have the new chain 
SR95PRELIMINARY listed, then click on chain SR95 and click on the Delete 

icon . When prompted, click Yes to delete the chain. 
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Locate New Beginning Point 
Now, we can set up the objects for our new proposed chain SR95. 

The chain currently starts at 295+00 and we want to back it up to include the Poplar 
Creek drainage structure. A preliminary look at the vertical suggests that our new 
beginning needs to be at 287+00. To give ourselves additional adjustment room, we 
will extend the centerline back 1000’ to 285+00. 

1) Before storing any new objects in COGO, we should set the visualization and 
feature. In the COGO dialog, click on the visualization control and set it to 
Permanent Visualization. Click on the Browse button to the right of the 
feature name field. In the SMD item dialog, go to Design and choose feature 
D_POINT.  

 

Once the feature has been selected, click OK to accept. 

Back in the COGO dialog, we can see our feature name has been set. Feature 
D_POINT should be used for centerline COGO set up by Design personnel. 
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NOTE:  
Temporary Visualization graphics go away when COGO is exited. 
Permanent Visualization writes the graphics to the DGN file so that when 
COGO is exited the graphics remain. 

2) After review of the existing roadway, we have determined that we can go back 1000’ 
and still be in the same tangent section. Click on the Locate Traverse icon to 
locate and store a new beginning point for our chain. 

 

 

3) In the Locate Traverse dialog we need to make the following settings as shown.  

Locate Point: D101 (our new point) 

Station Point: S101 (the original beginning point, the point we are locating from) 

Direction: Pa To Pb   TS SC102B & S101 (rather than keying in the 
calculated angle we will use the point to point option to set the direction) 

Distance: Distance 1000 
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Once the settings are made click on Locate to initiate the command and store the 
new point. 

4) Close the Locate Traverse dialog.  Back in the COGO dialog, we can see our new 
point has been stored. In graphics our point has been visualized.  

Use MicroStation’s Fit View command to find your point graphics. 
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Copy COGO Objects 
In order to keep the copy of the original survey chain intact, we need to duplicate 
the remaining objects in the chain which include a spiral curve, a simple 
curve and the ending point. 

Spiral Curve 
1) Since the spiral curve contains 3 objects (2 spirals and a curve), the simplest way to 

copy it is to just re-define it with a new name. First click on the Redefine option in 
the COGO dialog. Then in the Navigator go to Spirals and double click on one 
of the spirals for curve S102. This opens up the Store Spiral Combinations By 
Tangents dialog with all of the settings for the current curve. 

 

Change the name to DC102 and click on the Store Spiral button. 

 

Dismiss the Store Spiral dialog. In graphics, we can now see our spiral curve. 
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Simple Curve 
2) Since our other curve is just a simple curve, we can just copy it. Click on the Copy 

Curve icon. 

 

In the Copy Curve dialog, key in new curve name DC103, highlight survey curve 
SC103 and click on the Copy Curve button. 

 

3) You may have noticed that the curve was visualized in graphics but it is yellow in 
color rather than white. This is because copied elements retain their original feature 
name, in this case survey feature CL.  
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Open the COGO Navigator and go to the drop down option Tools → Settings. In 
the Settings dialog, turn on the option for Single Click Enables List Cell 
Editing. Click OK on the Settings dialog. 

 

We need to change the curve’s feature to our proposed centerline feature D_POINT, 
so go to Curve. Click on the feature name CL on new curve DC103. The field 
should open for editing allowing you to key in D_POINT. Once entered hit the enter 
key to finish the change.  
You can Copy & Paste the feature name from the DC102 curve element. 

 

As soon as the Feature name is changed the curve is re-visualized.  
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You can click on the Visualize icon on the COGO Navigator to visualize any 
COGO element (It is the paintbrush icon).  

4) In the COGO Navigator, go back to the drop down option Tools → Settings. In 
the Settings dialog, turn off the option for Single Click Enables List Cell 
Editing. Click OK on the Settings dialog. This should be done to prevent any 
accidental edits. 

Point 
5) All we need now is our ending point so this time click on the Equate Point icon  

 

In the Equate Point dialog set the Equate From option to Single Point enter our 
new point name D104 and the Equate To point as S104. Once entered, click on 
the Apply button to store the new point. 

 

NOTE:  
The Equate button can be used to get points from curves and spirals. 
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Store Proposed Centerline Chain 
Now that we have all of the objects set up for our proposed centerline, we can store 
that chain. 

1) Click on the Store Chain icon or select Element → Chain → Store → 
From Elements from the COGO menu bar to invoke the appropriate dialog. 

 

2) Key in the chain name SR95, select the Begin Station option and enter a 
beginning station of 285+00 and build the list of COGO elements which will 
become a part of the chain. 

You can fill in the Elements comprising the chain by keyin OR by graphically 
selecting the visualized elements in the design file. Ensure that the elements are 
added to the list in the order which you want them to be stored as a chain. 

 

NOTE:  
The Element Selection options on the right of the dialog are only used if desired to 
help build the Element list on the left. 

3) Press Store Chain. Close the Store Chain dialog. 

4) In the output area of the COGO dialog, you will see the command where we stored 
chain SR95. Go to Navigator and click on the describe button to review our new 
chain SR95. You also may wish to describe chain SR95PRELIMINARY to 
compare the two. They should be the same except for the beginning point and its 
station.  
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4b. Horizontal Alignment Tools 
These tools are set up to build special curve combinations for interchanges or 
intersections, regular SCS spiral curves or even vehicle turning paths. These include 
3 center curves, taper curves or the complex curve and spiral combinations 
sometimes required for ramps in interchanges. 

To introduce you to these tools in the following exercise, we will assume that it has 
been decided to increase the design speed on our spiral curve (SCS DC102) to 60 
MPH from 50 as it was originally set up. We could look up the spiral lengths for that 
curve and use basic COGO to store it but instead we will use Horizontal Alignment 
tools to design a new curve. 

1) From the Project Manager workflow dialog click on Horizontal Alignment. If 
you have not used these tools before, you will get the following prompt. 

 

Click Yes. 

Minimize the COGO dialog. You should see the Horizontal Alignment 
Generator tool bar. 

 

2) First, we need to set some preferences. In the Horizontal Alignment 
Generator tool bar go to the drop down option File → Preferences. 

3) Under the first category Element Symbology set the Label Scale to 50 set 
Grouping to Graphic Group. Don’t worry about setting symbologies. We will use 
other methods to display horizontal alignments. 
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4) Click on COGO Element Names and set as shown so we can create new curve 
DC104. 

 

5) We do not need to change anything under Curve Design Tables since they 
reference tables based on AASHTO green book standards which are what we use. 
Skip down to Spiral Design Tables and using the browser button load the 
table HA_spiral_emax8.tbl from folder C:\Users\Public\Geopak 
Standards. This table contains spiral lengths and curve values based on 
superelevation E Max of 0.080 (8%). 
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NOTE:  
The following tables are available for spiral curve design and are based on values 
set on T.D.O.T. standard roadway drawings RD01-SE-2 & RD01-SE-3. 

HA_spiral_emax4.tbl E Max 0.040, Urban Desirable 

HA_spiral_emax6.tbl E Max 0.060, Urban Allowable 

HA_spiral_emax8.tbl E Max 0.080, Rural Desirable 

HA_spiral_emax10.tbl E Max 0.100, Rural Allowable 

We will not deal with Turning Paths in this course but we do have the following 
tables that are available for that functionality under C:\Users\Public\Geopak 
Standards. They are based on design vehicles defined in the AASHTO green 
books of 2001 & 2004 with adjustments for Tennessee use. 

HA_Turning_Path_TN_2001english.tbl 

HA_Turning_Path_TN_2001metric.tbl 

HA_Turning_Path_TN_2004english.tbl 

HA_Turning_Path_TN_2004metric.tbl 

6) Skip down to Parameter Formats. Set the Curve Parameter to 
Degree(Arc) and Spiral Parameter to Length as shown. 
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We are finished setting preferences so we can dismiss the dialog. 

7) Back in the Horizontal Alignment Generator tool bar go to the drop down 
option Tools → Spiral Combinations. This will open the Spiral Combinations 
tool box. 

 

8) We need to store a new SCS curve between tangents so click on the Place SCS 
(Intersecting Elements) icon. 
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9) Set Design Table to 60 mph 4 Lanes and Degree to 2° 30’ 0”. Make sure 
Back Spiral & Ahead Spiral are clicked on, Loop option is off and the Truncate option 
is set to None. Notice that the required spiral lengths are automatically filled in. 

 

10) Before we move on make sure you can see the visualized graphics for our proposed 

centerline. Use MicroStation’s Drop Complex  tool to drop the complex 
status of the complex chain. 

11) Go back to the Place SCS function. In the status bar you may notice that the tool is 
ready to go and is prompting us to Identify first element (look toward the 
bottom status bar, in the middle). Click on the tangent leading to our first curve. 
Click anywhere to accept that and then click on the tangent past the curve to 
initiate curve placement 

 

Click to the left of the alignment to accept that curve solution. 
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12) Open the COGO dialog up and review the output window and the spirals and curve 
that we created. 

13) Now, we need to use our new curve in our chain. Make sure Redefine is clicked on 
and go to the Navigator. Double click on chain SR95. In the Store Chain 
From Elements dialog change curve name DC102 to DC104. Be sure to reset 
the Begin Station option so that the chain’s objects would be re-stationed. By not 
doing so, you might accidently introduce ‘station equations’ into your chain. 

 

Click on Store Chain. 

14) Highlight chain SR95 in the COGO Navigator and click the describe button. Review 
the chain description. 
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15) You can close the Horizontal Alignment Generator menu bar and tool box since we 
are finished with them. 

4c. COGO File Functions 
1) To save an input file of your commands or output files of the results, from the COGO 

menu bar, select File → Input File Utility or click on the Input File Utility 
icon.   

 

 

2) Set the action option at the lower left to Save, enter a Name such as propcl and 
a Subject description, then click Apply.  

 

All input commands from this session are written to the file propcl101.i**. 
Remember the last 2 letters of the name is your operator code. 
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3) For an output file, use the Output option, enter a Name such as SR95, then hit 
Apply. All data currently in the output window is written to sr95101.o**. 

Prior to creating an output file you may wish to use the function 
 View → Command Output → Clear to completely empty the output area. 
Then describe all objects (points, curves, chains, etc.) you wish to save a report on. 

 

4) You may review the input file and/or output file by using the GEOPAK Text Editor 
accessed from the Road Tools task set. In the Task pane, scroll down to Road Tools 
and click the expand arrow on the right to open it up. The Text Editor is in the last 
group of tools. 
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Here is an output of the SR95 chain. 

 

5) Exit the COGO dialog. 

6) As you exit COGO you may be prompted to save an input file of the session. If you 
haven't, click Yes to save one. 

 

NOTE:  
It is NOT required that you save when exiting COGO. Data is automatically written 
to the COGO database GPK file and this is just a safety measure. It is only 
recommended when a lot of work has been done so that it could be referenced back 
to later if needed. 
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4d. Working Alignment – Define Chain 
Now that we have our proposed centerline chain, we have another piece of 
information for the Working Alignment definition.  

1) Access the Project Manager workflow dialog. 

2) Press the Define button to access the Working Alignment Definition dialog. 

3) Highlight the Plan View option and use the Browse button to populate the Chain 
field with our alignment name. 

 

4) Press OK to exit and save the new settings. 
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5. Horizontal Alignment Displays 
In this exercise, we display some graphics for our proposed centerline. 

5a. Accessing Design and Computation Manager 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager. 

2) Select the Plan View Design button from the Project Manager workflow 
dialog which opens the Plan View Design tool box.  

 

Select the Design and Computation Manager icon to invoke the Design and 
Computation Manager shown below. It can also be accessed from the Main Task 
group when the Civil Workflows are set. 
A secondary dialog will appear to be used in conjunction with the Design and 
Computation Manager dialog. 
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5b. Drawing Horizontal Alignments 
1) In the Design and Computation Manager dialog, select the following item: 

Drafting Standards → Roadway Horizontal Alignments → HA 
Roadway.  

 

2) Next, select the Draw Plan and Profile button from the secondary dialog: 
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3) Set the Element Type to Chains.  Chain SR95 should be displayed in the list box 
as shown.  Notice that the options that are to be drawn with the chain are already 
activated. Set the Label Scale to 50 if not set. 

 

4) To draw the chain, click on SR95 in the list box.  Use the MicroStation Fit View 
→ Active to see the chain. 
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NOTE:  
DO NOT double click on the chain name. Each click will display the chain and a 
double click will place two sets of graphics. 

5) Change the Element Type to Stationing and make sure the dialog is filled out as 
shown below. Annotate the alignment SR95 by clicking on the chain name in the 
list box.   

 

Close the GEOPAK Draw Plan and Profile dialog. 



Exercise 5 

GEOPAK V8i (SELECT Series 2) Horizontal Alignment Displays   5-5 

6) We have another application in D&C Manager that will place symbols for us at all of 
the alignment’s key points. Before executing the following steps, make sure your 
entire alignment is shown in View 1. 

7) Double-click on the following item in D&C Manager: 

Drafting Standards → Roadway Horizontal Alignments → HA Points 

 

NOTE:  
Since this D&C Manager item is run by a separate program double clicking on the 
item prompts D&C to open the application and run it. These types of items can 
usually be recognized by their description which starts with a verb such as place, 
draw, access, etc. 

8) The Place Horizontal Alignment Points dialog is displayed. 
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All GEOPAK jobs found within the current active folder are listed in the Job drop 
down box.  If this tool was used previously for that job, the last chain processed is 
set as well as the last horizontal alignment type which was used.  Scale defaults to 
active scale set in the MicroStation DGN file. 

9) The Job should be set to 101 and the Chain to SR95. Set the Type to Proposed 
Roadway Centerline and if not already set, change the Scale to 50. 

Click the Place Points button to place the horizontal alignment point symbols for 
chain SR95. 

10) Review the results of the previous steps used to display and annotate the proposed 
centerline SR95.  

You may wish to turn off the visualizations from COGO work done for the chain. 
They are on level DESIGN - CENTERLINE - Proposed GPK 
Visualizations. 

 

11) Exit the Design and Computation Manager dialogs. 

12) Dismiss the Plan View Design tool box. 
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6. Existing Ground Profile 
In normal work flows, survey will develop a ground profile for the preliminary 
centerline. Only when the proposed centerline is altered from that location would it 
be necessary set up a new ground profile. Since we have altered the preliminary 
centerline, we need to generate a new ground profile. 

In this exercise, we demonstrate the use of the Existing Ground Profile tool from 
Project Manager which generates and stores a profile in the GPK file which we later 
display. If only graphics are needed or in cases where multiple surfaces need to be 
profiled at one time, then the Draw Profile tool should be used. 

6a. Extract Existing Ground Profile 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager.  

2) Select the Existing Ground Profile button from the Project Manager 
workflow dialog. 

3) Create a new run called SR95 then select the run and press OK.  
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4) Populate the Ground Profile dialog as shown and press Apply. Enter the 
Profile Name as SR95GRN. All ground profiles should include the letters GRN 
to show that they are existing ground profiles and can be recognized separately from 
proposed roadway profiles. Intersect mode should always be used for the most 
accurate profile displays. 

 

NOTE:  
The beginning and ending station of an alignment can be filled in automatically by 
placing the cursor in the blank field and pressing Enter. 

5) When prompted for an input file name use the default name (j101o**.inp) as 
shown in the Ground Profile Input File dialog below and press the OK button. 

 

6) When prompted to store the profile, press Yes. 
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7) Press Yes to delete the 3D line string in the design file. 

 

8) After the profile is stored, exit the Ground Profile dialog and Save Settings. 

9) Access Coordinate Geometry.  (Press the Coordinate Geometry button on the 
workflow dialog).  

10) Access Navigator and go to Profiles. 

 

11) Select the profile ‘SR95GRN’ and press the Describe icon. 
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12) Review the profile information in the COGO output display window. 

 

13) Close the Coordinate Geometry dialog (use X in upper right corner of the dialog).  
When prompted to save the COGO session press NO. 

6b. Drawing Ground Profiles 
1) Place a line in the design file, the end of which will be a reference point for locating 

the origin of the profile and the profile grid (lower left corner).  Once the profile 
and the grid are drawn the line may be removed. The line can be placed in any clear 
area of the design file away from the area for the horizontal alignment graphics. For 
this exercise please use the following XY coordinates. 

XY = 2480000,587000 XY = 2490000,581000 

After placing the line, use fit view or zoom out to locate the line. 

2) Access Design and Computation Manager by selecting the Plan View 
Design option on the workflow dialog and then selecting the Design and 
Computation Manager icon from the tool bar or from the Main Task group when the 
Civil Workflows are set.   
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3) Select the item Drafting Standards → Exist. Profiles → Exist. Ground. 
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4) Press the Draw Plan & Profile button on the secondary dialog.  The Element 
Type is automatically set to Profiles. The Label Scale should already be set to 
the desired scale of 50. 
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5) Click on the existing ground profile ‘SR95GRN’ to invoke the following profile 
parameter dialog. Populate it with the station, scale and elevation parameters 
shown.  

 

NOTE:  
You do not need to enter a value in the Strip Grade Increment box. This is used to 
display elevations along the profile at the spacing entered. Normally this information 
is not needed. 

6) Set the DP X and Y coordinates by clicking on the DP button and then 
snapping to the right end of the line placed in the design file in step 1. 
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7) We will need the GEOPAK Profile Cell later so go ahead and set it up. Click on the 
drop down for PGL Chain and choose the chain name SR95. Now click on 
Draw Cell at XY. This places this special cell which holds all of the control data 
defining this profile set up. It can be identified while using any GEOPAK profile 
function to define the control information. 

8) Press OK to display the ground profile. The existing profile should now be plotted 
in the design file. Line weights have been turned on in this image to enhance 
visibility. 

 

9) Exit the GEOPAK Plan and Profile Draw dialog and review your profile. 

10) Do not exit the D&C Manager; go on to the next section. 
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6c. Drawing Profile Grids 
1) Go to D&C Manager. 

  

Double-click the item Profile Grid and the Draw Profile Grid dialog opens.  
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2) The current active scale is read from the DGN file and is used to set the default 
Horizontal and Vertical Scale. Make the following settings to draw the profile grid for 
SR95. 

Horizontal Scale = 50  

Vertical Scale = 5  

Minimum Elevation = 700  

Maximum Elevation = 850 

Beginning Station = 28500  

Ending Station = 34789.04 
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3) When all control values have been set, click on the Draw Profile Grid command 
button. 

You are prompted to Data Point at Profile Origin. The profile grid range is 
shown dynamically. Line weights have been turned on in this image to enhance 
visibility. 

 

NOTE:  
If the profile coverage is not acceptable, you may give a Reset to stop and adjust 
the control values. 

4) Data point at the reference origin location of the profile area. 

Profile with profile grid displayed. 

 

5) Click Cancel in the Draw Profile Grid dialog top close the tool and exit D&C 
Manager. 
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6d. Working Alignment - Define Existing Profile 
We are setting the Profile View and Location sections of the Working Alignment 
Definition in Project Manager. 

1) From the Workflow dialog of Project Manager, press the Define button. 

2) Select the Profile View option and populate the dialog as depicted below (the 
Design File is ROSR95Alignments.dgn). 

 

NOTE:  
We have not designed the proposed profile; therefore, we will return later to populate 
this field. 
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3) Select the Location option and populate the dialog as depicted below. This can 
all be done automatically by clicking on the Identify Cell button.  

Data point anywhere on the GEOPAK profile cell graphics to identify it and data 
point to accept. 

 

All control values are filled in. 

 

4) Press the OK button to save the updates and close the dialog. 
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7. Proposed Roadway Profiles 
In this exercise, we will use the Vertical Alignment Profile Generator tool to set up 
the proposed vertical alignment profile for our roadway. 

7a. Generate the Proposed Profile 
1) Open the MicroStation file: 

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager 

2) Select the Vertical Alignment button from the Project Manager workflow 
dialog. 

3) All of the information in the Settings dialog should be automatically populated 
based upon the information we set up in our working alignment definition. 

 

Click the OK button to commence developing of the proposed profile. 
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4) The Profile Generator dialog is opened for us but before we start storing our profile 
lets look at some additional controls. In the dialog, go to the drop down option File 
→ Preferences 

These special controls may be used to control how stations, lengths or grades are 
set. We use the defaults for the most part but click on Window Center Current 
VPI so we will always see the area we are defining at the time and set the vertical 
curve control option to Maintain Curve Length. Click on the OK button once 
settings are made. 

 

5) In the Profile Generator dialog go to the drop down option File → K Value Table. 
By default the standard K value file tdot01.kvl is loaded. This file contains K 
values based on T.D.O.T.’s RD01 standard roadway drawings. Click on the 
Cancel button retain the current settings. 

 

If you need to reset this table, in the K Values dialog select the drop down option 
File → Open, navigate to the folder C:\Users\Public\Geopak Standards and 
load the desired file. Click on the OK button once settings are made. 
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6) Now that we have made our initial settings, we can start setting up our proposed 
profile. Set the first VPI Station to 287+00 and Elevation to 781.50 as shown 
in the diagram below. Be sure to press the Enter key after each entry is made. 

 

In graphics, we can see our VPI position point. 

7) Press the Insert button on the right and complete the VPI Station and Elevation of 
the subsequent VPIs as detailed in the table below. 

VPI Station Elevation 

2 304+10 787.00 

3 333+50 816.50 

4 347+50 793.32 

NOTE:  
The Dynamic button allows you to set VPIs by eye when values are not yet known 
and can be used in conjunction with the Lock or Inc (increment) buttons to the 
right of the station & elevation values. Lock will lock that particular value down while 
the other is dynamic. Inc will force dynamics to use value controls set in preferences. 
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8) Press the Previous button at lower left of dialog to return to VPI #2 as shown in 
the diagram below. 

 

9) Make sure the curve type at the bottom is set to Symmetrical and set the 
Design Speed to 60. The K value is automatically read from our table and a curve 
length of 92.72 is computed.  

We need an even length of curve preferably in 50 or 100 foot increments and this 
VPI has a small algebraic difference so go ahead and change the curve length to 
200. 

 

The new curve length is used to calculate a new K value which is used with our K 
value table to indicate that we are now meeting 70 mph vertical design speed 
criteria. 
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10) Press the Next button at lower right of dialog to preview the information for VPI #3.  
We only need a 50 mph vertical curve here but go ahead and set a curve length of 
1200 which yields a Design Speed of 70 mph. 

 

In graphics, we can see our curve as specified. 

 

NOTE:  
Graphics shown while using Profile Generator are temporary visualizations and 
disappear when the program is exited. Graphics for the plans are displayed using 
D&C Manager which we will do in the next section. 

11) Save the proposed profile by selecting File → Save Profile from the Profile 
Generator dialog. Enter SR95 for the profile name and click OK to save. Click 
OK again to dismiss the Confirmation message box. 
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12) Exit the Profile Generator dialog. When prompted to save your profile, you can 
answer NO since we did that in Step 11. When prompted to save your Vertical 
Alignment settings, press YES. 

7b. Drawing the Proposed Profile 
Next, we are drawing the proposed profile SR95 utilizing D&C Manager. 

1) Access the D&C Manager. 

Select the item: 

 Drafting Standards → Roadway Vertical Alignments → VA Roadway. 

 

2) Press the Draw Plan & Profile button on the secondary dialog. 
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Plot the proposed profile ‘SR95’ using the parameters as shown in the following 
dialogs.  Options required for proposed roadway profile line work are set by default. 
Do not turn on any annotation options. All annotation is placed with a separate 
program which we will use next. Single click on the profile name in the Draw 
Plan & Profile dialog. 

Since we have our profile control information set up in the working alignment, all of 
that data in the Profile dialog is filled in automatically. Review the data then click 
OK to draw the profile. 

           

3) Exit the Draw Plan and Profile dialog then review the proposed vertical alignment 
line work in MicroStation.  
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4) We run a separate special program to place all of the vertical alignment annotation. 
Double-click the item: 

Drafting Standards → Roadway Vertical Alignments → VA Labeler 
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5) The Label Vertical Alignment Dialog is opened.   

 

6) Click on the Identify Profile Cell command button and click on the Geopak 
profile cell for our profile. The window shade button on the upper right of the dialog 
can be used to get the dialog out of the way as you identify the profile cell.  Just 
click it again to enlarge the dialog after identifying the cell. 

After reading the profile cell and populating the Profile Settings at the top of the 
dialog, the GPK file is read for all profiles/vertical alignments applicable for display 
on this profile and fills the profile list box. 

7) Next, set the Type of profile to be labeled. The default is Roadway which is what 
we need.  Options to label special ditches or private drives are also available. The 
type controls text sizes, orientation and symbology. 

8) Set the Profile option to SR95. 

9) Set the Scale to 50 if not set already. The current active scale is read when the 
program is started to fill in this field automatically. 



7-10   Proposed Roadway Profiles GEOPAK Road Course Guide 

10) Finally, the label options can be adjusted as needed. The type of profile to be 
labeled determines which default options are turned on.  For this class, we will use 
the defaults for Roadway. 

Note: 
If a Maximum Speed Label is entered in the keyin field which is provided, then all 
curves exceeding the given speed are labeled with the speed and a “+”. Any vertical 
curves where the speed is less than this value will also display a warning message 
as well. 

11) Now that all control values are set, click on the Place Labels command button 
and the vertical alignment is annotated. Review the annotation graphics and click 
the red X to close the dialog. You can close D&C Manager as well. 

. 
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7c. Working Alignment - Define Proposed Profile 
We are completing the Profile View of the Working Alignment Definition in Project 
Manager. 

1) Press the Define button from the workflow dialog of Project Manager. 

2) Highlight the Profile View option and populate the Proposed Profile field as 
depicted below using the Select button. 

 

 

3) Press the OK button to save the updates and close the dialog. 
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8. Existing Ground Cross Sections 
In this exercise, we will start setting up our cross sections by first defining the 
locations where we want them with MicroStation lines or line strings called “pattern” 
lines by GEOPAK. Then we will use the Draw Cross Section tool to cut existing 
groundlines from our existing TIN file. 

8a. Draw Patterns 
1) Open the MicroStation file:  

C:\Projects\Roane\SR95PoplarCr\ROSR95RoadwayPattern.dgn 

Access Project Manager. 

2) Select the Draw Pattern button from the Project Manager workflow dialog. 

3) Create a new run called SR95. 

4) Populate the dialog as depicted below. Chain name and stations are set 
automatically. Set the Offsets to 300 and layout option to Even at 50. 
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Double click on the symbology review window to make the following settings. 
Level name is DESIGN – CENTERLINE – Proposed. Click OK to save the 
settings. 

 

NOTE:  
The symbology settings for pattern lines are not critical since they are not used in 
the plans. If more than one set of roadway patterns are placed in a file, it is important 
to make some part of their symbology different, such as the level, so that they can 
be recognized correctly by GEOPAK during cross section processing. 

5) Press Draw Pattern Lines to initiate the plotting of the patterns into the design 
file. 

6) Review the pattern lines in MicroStation. The alignment DGN file has already been 
referenced to this file and you can see the pattern lines along it. 
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7) Exit the Draw Pattern dialog and Save Settings for the run. 

8b. Drawing Skewed Pattern Lines 
Skewed pattern lines are used to cut culvert cross sections for drainage structure 
development. When those structures have been designed, the Pattern line tool can 
be used to plot the centerline for box structures or pipes at the required length. 

This information is provided for reference only. Do not do this for 
the class. Review and then go on to Section 8c. 

1) From Project Manager or the GEOPAK Road tool frame activate the Draw 
Pattern tool.  

2) Set the job number and chain name for the roadway.  

3) Change the placement control at the bottom for placement Once and change 
symbology settings as desired. 

NOTE:  
When drawing pipes, the required symbology should be set using proposed pipe 
items from D&C Manager with Place Influence active so that quantities can be 
calculated later... 

4) Only the Beginning side of the dialog should be active now and there you now can 
set the Offset LT, Station & Offset RT. 

5) If the drainage structure is at 90 degrees (0 degrees on dialog) you can go ahead 
and hit Draw Pattern Lines to draw the pattern line for the structure. If the 
structure is skewed click on the Skew Angle option.  

6) Enter the Skew value. Skew values in this dialog are measured from a normal 90 
degree line not the centerline as we normally consider them. So to get the skew 
value to enter in the dialog, subtract the skew from 90.  

Skews to the left should be entered as positive and skews to the right as negative. 
(Example: 60 degree skew left is 90-60=30) 

7) Hit Draw Pattern Lines to draw the structure centerline or pipe. 
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8c. Generate Existing Ground Cross Sections 
1) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

NOTE:  
When creating a new cross sections design file, always use the seed file 
SeedXS.dgn. This file has special settings which are different from the normal 
seed2d.dgn DGN seed file. This is required for proposed cross section processing 
and if not used can generate errors and fail to build proposed sections. 

2) Press the Existing Ground Cross Sections button on the Project Manager 
dialog. 

3) Create a run called SR95. 

4) Set up the existing ground cross-sections by populating the dialog as shown. 

Start by changing the XS Cells option to By DGN File which will change the 
items shown in the dialog. Pattern line symbology should be set as we did in the 
previous section. 
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Click on the Surfaces tab to open this dialog display. Make the settings in the 
lower portion first. Double click on the symbology review windows to set the 
symbology for groundlines and voids as shown below this dialog. 

 

Void symbology is the same as groundlines except for the color which is red (6). 
Level name is SURVEY - GROUND - Top of Ground. 

 

NOTE:  
It is critical for plotting purposes that Line Strings always be used for groundline 
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displays. When lines are used with line code 3, short pieces of line will appear solid 
on plots making them difficult to see on gridded cross section sheets. 

5) When the settings in the lower portion are complete click the Add Surface button 
on the side. 

 

6) Next, press the Draw button to place the cross section graphics. 

7) Exit the dialog and Save Settings for the run. 

8d. Review Cross Sections 
1) Open the Road Tools task group and select the 

Cross Section Navigator tool from the cross 
section tools. 

 

 

 

2) Use the Cross Section Navigator to browse and check your existing cross 
sections.   

 

3) Exit the XS Navigator dialog when done.  
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8e. Modify Pattern Line Symbology 
In preparation for the following exercise, complete this step: 

1) Re-open the MicroStation file  

D:\Projects\Roane\SR95PoplarCr\ROSR95RoadwayPattern.dgn 

Utilizing the MicroStation Change Element Attributes command, modify the 
color of the pattern lines drawn at stations 285+00 through 286+50 and station 
347+89.04 to color = 3. This will limit the processing of the proposed cross sections 
to the station range of the proposed roadway profile (287+00 to 347+50). 
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8f. Working Alignment - Define Patterns & Cross 
Sections 

We are completing the Pattern, Cross Section and Existing Ground sections of the 
Working Alignment Definition in Project Manager. 

1) From the workflow dialog of Project Manager, press the Define button. 

2) Highlight the Pattern option and populate the dialog as depicted below. Since 
we are in the pattern file, you can use the Match button to accomplish this task 
rather than manually typing in the information, click the button and data point on 
one of the white pattern lines to set. These symbology settings control searches for 
cross section patterns by other tools 

 

3) Double click on the symbology review window next to Placement at the bottom 
and set the same values in the Set Feature dialog. This symbology control will be 
used if pattern lines have to be placed again for this roadway. 
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4) Click OK to save the symbology settings and OK again on the main dialog to save 
the Pattern settings. 

5) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

6) Use Cross Section Navigator to go to your first cross section. 

 

7) From the workflow dialog of Project Manager, press the Define button. 

8) Highlight the Cross Section View option and using the File button identify the 
roadway cross section file. Notice that chain & station limits are read from the file. 
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9) Highlight the Existing Ground option and populate the dialog as depicted 
below. Use the Match button and identify the groundline. For possible Void areas 
add the color 6 as shown. 

 

 

10) Double click on the symbology review window next to Placement at the bottom 
and set the same values in the Set Feature dialog (use color 0). 

 

11) Click OK to save the symbology settings and OK again on the main dialog to save 
all of the Cross Section and Existing Ground settings. 
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9. Proposed Cross Sections - Preliminary 
This exercise is set up to illustrate setting up preliminary roadway cross sections 
without superelevation or special transition areas specified. This basic set up is all 
that is needed to do horizontal and vertical alignment investigation. 

For our class project, a 4-lane divided median rural section will be used from Station 
287+00 to Station 328+25, and a 5 lane urban section will be used from Station 
328+25 to Station 347+50. The purpose of this exercise is to process a preliminary 
cross section run to check slopes, etc. 

NOTE:  
This project is set up to illustrate different roadway types as well as transitioning 
between them. When using this as a reference, consider the type of roadway on 
your project and look at the sections which would apply. 

9a. Initial Set up 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

Access Project Manager. 

2) Choose Proposed Cross Sections from the Project Manager dialog and 
create a run called Prelim. Then double-click Prelim and the following dialog 
will appear. 
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3) Click on each of the following items and make the settings in the dialog as given. 

XS DGN File: This filename should be automatically defined as 
ROSR95MainlineXSections.dgn 

Pattern: Use Working Alignment Definition 

Existing Ground: Use Working Alignment Definition 

Shapes: Set the Shape Option to Shapeless. We will not be setting 
superelevation for this preliminary run. 

9b. Define Roadway/Shape Clusters 
1) Next, select the Shape Clusters item to invoke the following dialog display. 

 

First, we will define the Chain, Tie and Profile for the shape clusters. 
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2) Press the selection arrow button next to Chain and choose chain SR95. 

 

3) Press the selection arrow button next to Profile and choose profile SR95. 
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4) Next, enter a Tie distance of -24 in the Apply Profile at: Tie field and press 
the Add button to include this shape cluster in the list box as shown below: 

 

This shape cluster is for building the left side of our 4 lane with depressed median 
section. Now, we can go ahead and set up the other roadway areas. 

NOTE:  
Whenever the finished grade is a constant offset from the centerline, then a Tie 
value is specified. Only when that offset value varies from section to section will the 
alternate setting for a PGL chain be used. We will illustrate this in a later exercise 

5) Repeat Step 4 for a Tie of 24 and for a Tie of 0. 

Your list box should look the same as shown below: 
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6) To define the Side Slope conditions and the Criteria Files required to produce 
our preliminary proposed cross sections, we simply highlight the first cluster in the 
list box (Tie -24) and press the Typical button. 

Note:  
The Typical button will not be available until a shape cluster has been selected from 
the list box. 

7) You will now be able to traverse the Typical Section Library created for T.D.O.T. 
roadway design standards. Use the scroll buttons to move up and down the list. 

As you select a typical section in the list box on the left, the dialog will update to 
display a schematic of the selected typical section.  
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8) From the typical section list, select the cell “4LNDMD – 4 LANE DEPRESSED 
MEDIAN ROADWAY”. 

 

Click on the Description button, it will open a document file describing the 
features and application of the typical section as well as a listing of all variables used 
to form the section. Review this file then exit using Files → Exit. 
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9) Notice that within the Template area, information describing the process that this 
template is designed to work with and also the option button is available for you to 
define the Left or Right side of the Roadway for use with this typical section.  

Since we selected the shape cluster with a tie value of –24, we need to set the 
control to Apply to Left Roadway. 

 

10) In the Range area of the dialog, change the Station option to Apply to Station 
Range and provide a beginning Station of 287+00 R 1 and an ending Station of 
328+25 R 1.  

 

Station 328+25 is where this project switches to an urban crown roadway 

NOTE:  
Setting a chain name in this section is only necessary when applying a typical 
section to a roadway chain other than the one the cross sections are based on. 
Some examples of this might be a ramp at an interchange, a frontage road or 
perhaps a special ditch running outside the proposed roadway section. 

11) Press Apply on the Typical Sections dialog. 

The process of populating the side slope left and right station ranges and the 
required criteria files for this shape cluster is initiated. During this process all of the 
required criteria files are copied to your project directory. 
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After the processing is complete, the Proposed Cross Section dialog will re-appear 
and will now include the side slope and criteria settings for that roadway cluster. 

 

NOTE:  
Sometimes the criteria description text does not display under Shape Clusters. This 
is a minor issue with the software and does not pose a problem. 

12) Select the Shape Cluster with a +24.0 Tie and repeat the previous steps for the 
right roadway, this time being sure to change the template information to Apply to 
Right Roadway. 
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13) Press Apply. Now, we can see that the right roadway of the 4 lane with depressed 
median area has been set up. 

 

NOTE:  
Since the criteria files applied with typical sections are copied to the project 
directory, it will be necessary to update those files as well as the originals in the 
standard criteria directory anytime an update is put out by T.D.O.T. Roadway Design 
Division CADD Support. There is a tool to help you accomplish this from the 
MicroStation menu bar at T.D.O.T. → Cross Sections → Update Project XS 
Criteria Files.  

14) Select the Shape Cluster with a Tie = 0 and press the Typical button. 
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15) Select from the list box, the typical section “5LNUS – URBAN W SHLDS 5 
LANE.” 

 

This typical was created to work with a single roadway/shape cluster. Notice in the 
Template area that the Left and Right Roadway button is no longer available. 

16) Set the Station Range from 328+25 R 1 to 347+50 R 1 as shown below: 
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17) Press Apply. 

 

18) Notice that in the above Side Slope Conditions, the station range to be processed 
must be “less than” (<) 347+50. This presents a problem since we have a proposed 
cross section at 347+50. 

In the Side Slope Condition area, highlight the Side Slope LT condition and 
press the Modify button to access the Side Slope Modification dialog. 

Place your cursor in the dialog keyin field after the symbol “<” and insert the “=” 
symbol as shown below. Press OK to save the change and return to the main 
dialog. This will insure that our station 347+50.00 is processed on the left side. 
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19) Repeat the previous step for the Side Slope RT condition. 

9c. Define Variables 
1) Select the Define Variables item from the Proposed Cross Section dialog list 

box to invoke the following dialog. This tool scans all of the criteria files for the 
Define Variables and allows you to define them for each proposed cross section 
run. 

 

NOTE:  
DGN Variables refer to graphics that control proposed cross section formation. 
Several of those are automatically set by T.D.O.T. Roadway Design Division criteria 
files including edge of pavement, shoulder lines and guardrail slope limit lines. 

2) Select the Variable “Centerline Name” and set the Value to SR95. To do this, 
enter the name in the Value field and press the Modify button. 
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NOTE:  
If the Modify button is not pressed, the change will not be made. 

3) Select the Variable “Plan DGN” and set the Value to ROSR95Proposed.dgn. 

 

4) Select the Variable “XS DGN” and set the Value to 
ROSR95MainlineXSections.dgn. 
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5) Review the other variables in the list. 

If slope lines are desired in the plan view, then set variable Place Slope Lines in 
Plan? to Y. These criteria files have been developed to plot the slope lines 
automatically as the proposed cross sections are being processed. 

There are 3 define variables to control labeling of the finished grade elevation by the 
cross section criteria files. They include an option to place the label or not, label 
prefix and angle of label. In most cases the defaults can be used. For this exercise 
use the default values as shown below.  

 

If no finished grade label prefix is desired, then none should be entered for the 
prefix. 
We do not need to change anything else for this roadway but on other projects 
default values may need to be adjusted. Pavement and shoulder widths are only 
used when no pavement or shoulder lines are found in the PLAN DGN file and no 
superelevation shapes are specified (shapeless). 
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9d. Plot Parameters 
1) Select the Plot Parameters item from the Proposed Cross Section dialog list 

box to invoke the following dialog.  

 

Double click on the Cross Section Lines symbology review box to invoke the 
following dialog and set symbology as shown. The level name is DESIGN - 
TYPICAL - Finished Grade and Subgrade. 

 

Press OK when complete. 
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2) The Line Text option is used by Geopak to annotate the finished grade.  Since our 
criteria files take care of that annotation as well as labels for station and baseline 
chain name, none of the Text options need to be set. 

All options except for Pavement Shapes under the Plot section should normally 
be off when using T.D.O.T. Roadway Design Division Typical Sections and criteria 
files. They may be applicable in certain special case scenarios. Remove the check 
marks from all items except for Pavement Shapes under the Plot section. 
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9e. Processing Proposed Cross Sections 
1) At this point, we are ready to process the proposed design cross sections for the 

chain SR95 with the profile defined as SR95. From the Proposed Cross Sections 
dialog, select drop down option File → Run. 

The following dialog is invoked where you may define where you want to see the 
cross section processing information, in an output file or on the screen only. 

 

2) Select To Screen and activate the Pause on Each Section toggle to view 
the first design section once it has been drawn. 

Criteria Viewer is used to step through the criteria file syntax to track problems 
during development and is usually not needed by designers.  

You can use the Disable View Update anytime you are processing cross 
sections for a long or complicated roadway to speed up processing time. 

NOTE:  
When errors occur, change the “To Screen” option to “To Log File”, and then press 
Apply to generate the log file. Use the GEOPAK Editor (or any text file editor) to 
open the log file to determine the problem. Critical error messages are usually listed 
at the end of the file. The problem which caused the error is usually in the lines 
above the error message. 

3) Press Apply. 
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4) All DGN files are searched for defined control graphics and the first section is 
plotted. Review the proposed cross section for Station 287+00. Turn off the 
Pause On Each Section toggle and press the Continue button to complete 
the proposed cross section generation process. 

 

5) When processing is complete, press EXIT to return to the Process Cross Sections 
dialog. 

6) Close the Proposed Cross Sections dialog box by using the “X” on the upper right 
of the dialog or by using the Files → Exit drop down option. 

When prompted to Save the run, click Yes. 

 

7) Take a moment to review your proposed cross sections with the Cross Section 
Navigator. 
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9f. Working Alignment – Define Proposed Finish 
Grade 

Now that we have the information for our proposed cross sections, we need to 
update our Working Alignment Definition in Project Manager. 

1) From the Workflow dialog of Project Manager, press the Define button. 

2) Highlight the Proposed Finish Grade option and populate the dialog as 
depicted below.  Click on Lv Names, Styles & Weights and then click on 
the Match button and identify any proposed cross section line work. 

Projects that include side roads will need to include the level and weight for special 
ties to the ground. These are used during earthwork calculations.  Click the 
Select buttons on the right and add level DESIGN - EARTHWORK - Special 
Tie to Ground and weight 0. 

 

3) Click on the Display button, all cross section graphics should be highlighted. This 
is a way to see what elements meet the symbology criteria that you have set. Click 
on the UnDisplay button to un-highlight. 

4) Press OK to save your changes and exit the dialog. 
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10. Proposed Roadway Tracking 
This exercise demonstrates tools for tracking along roadways in the plan, profile and 
cross section views. The first tool we will look at is Port Viewer which allows tracking 
along all of these at one time. The Active Chain Control tool is shown which can be 
used for “on the fly” tracking to quickly check stations, offsets, elevations, etc. 
Tacking on cross sections using the Cross Section Navigator tool is illustrated. 
Finally 2 of our TDOT Roadway Design Division tools are shown as alternatives that 
can be used for tracking in plan and profile. 

NOTE:  
For tracking on existing or proposed digital terrain model TIN files use the Height 
tool as illustrated in chapter 3. 

10a. Port Viewer  
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

Access Project Manager 

2) Click on the Port Viewer button at the upper right of the dialog.  
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3) The Port Viewer dialog is displayed as shown below. Views are dynamically 
turned on to display plan, profile and cross sections from the definitions established 
in the working alignment.  

Depending on how view 1 is set, you may need to go to the drop down option 
Window → Tile. 

 

NOTE:  
Port Viewer attaches all associated DGN graphics files as references to each other 
to perform its functions. 

4) Use the VCR buttons in the Port Viewer dialog to scroll through the design, profile 
and cross sections. Views may need to be adjusted by zooming etc. for best view. 
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5) Go to MicroStation’s menu bar option File → References and turn on the 
Survey topo (RO095-01Survey.dgn) reference file display. 

Keyin station 336+50 and all views jump to that location. Notice that on the right 
design produced slopes encroach on a cemetery. In an up-coming exercise, we will 
update our profile to fix this problem. 

 

6) Change the Cross Section Option to XS DTM. 

 

7) Press the Set button then move your cursor in the Plan View. As you move the 
cursor around you will be able to preview the dtm/ground information in the XS View. 

8) Set the Active view to Profile View and click the Set button again. Now, you 
can pan the cursor in the Profile view and see the dynamic tracking in the other 
views. 
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9) Close the Port Viewer dialog by clicking on the X in the upper right corner. 

10) Close the MicroStation DGN file, do not Save Settings before exiting. 
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10b. Active Chain Control 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

2) From the MicroStation menu bar click on the drop down option Applications → 
GEOPAK → ROAD → Active Chain Control or from the main tasks when 
using Civil Workflows click on the Active Chain Control icon. 

 

The Active Chain Control bar is opened. 

 

3) Set the Chain to SR95 from the chain list. 

4) The icons on the right numbered 1 through 8 represent the 8 MicroStation views and 
what type of tracking they are set for. By default they are set to Plan (chain) tracking. 
If you right click on them you get the option to change setting to Plan, Profile or 
Cross section tracking. 

 

Right click on the icon for View 2 and set it to Profile. 

5) Click on the Curvilinear Coordinates icon to open the tracking dialog. 
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6) Move your cursor around in view 1. Notice that you are tracking station and offset 
along the alignment. You can click the lock toggle to the right of either value and 
only track the other, 

 

7) Turn on view 2. The profile should be showing there already. When we set it to 
profile tracking, it automatically looked for the GEOPAK profile cell for chain SR95 
and used it to set the view. 

8) Move your cursor around in view 2. Notice that you are tracking station and elevation 
in this view.  
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You can actually move from view 1 to 2 and see the tracking change from Plan to 
Profile. 

9) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

10) Right click on the icon for View 3 and set it to Cross Section. Open view 3 in 
MicroStation. 

11) Right click on the icon for View 3 again and select the new option now available, 
Cross Section Navigate. 

 

12) Move the XS Navigate tool into view 3, use it to navigate to a given station and then 
move your cursor around in the view. The offset and elevations are tracked in the 
Curvilinear Coordinates dialog. 
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NOTE:  
This part of the Active Chain Control tool can be a little cumbersome to use. You can 
actually use a function on the regular Cross Section Navigator tool to get the same 
results which is illustrated in the next section of this exercise. 

13) If you right click on the Active Chain Control tool away from the icons, you can 
control what icons are shown on the bar. Right click and turn off the icons for views 
4-8. 
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14) Close Active Chain Control by clicking the  on the upper right of the bar. 

10c. Tracking with Cross Section Navigator 
1) Select the Cross Section Navigator tool from the Road Tools task group. 

Navigate to one our proposed cross sections.  

On the Navigator tool bar to the right of the navigate arrows are several drawing 
tools. Click on the DP Offset Elevation icon. 

 

2) This tool is set up to send a data point for you based on elevation and offset values. 
You can enter those but you can also pick the cursor option. Click on the Get 
Cursor XS Position icon. 

 

3) Move your cursor around in the view. The Elevation and Offset readings are 
displayed in the tool.  
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10d. Tracking with the Label Station/Offset Tool 
Although the T.D.O.T. Roadway Design Division Label Station/Offset tool is set up 
primarily to label stations and offsets in the plans, it can be used as just a tracking 
tool for these values as shown below.  

1) In D&C manager activate Drafting Standards → Tools → Labeling → 
StaOffsetLabel or with the T.D.O.T. Roadway Design Division interface choose 
drop down option TDOT → Tools → Place Station Offset Label. The Label 
Station/Offset dialog appears.  

All Geopak jobs found within the current active folder are listed in the Job drop 
down box with its chains listed in the Chain drop down box. If this tool has been 
used previously, the job number and chain name are remembered and will be used 
to populate those fields. Set those values as needed. 
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2) Click the Dynamic button to initiate the dynamic mode.  Move the cursor off the 
dialog and a temporary label will follow the cursor with the station and offset values 
changing dynamically on the screen and within the dialog’s text boxes as the cursor 
moves along the specified chain. 

 

10e. Tracking with the DP Profile Station Elevation Tool 
The T.D.O.T. Roadway Design Division DP Profile Station Elevation tool is set up to 
send data points to the profile based on station & elevation or just to label stations 
and elevation there. It also includes a dynamic function so it can be used as just a 
tracking tool for these values as shown below.  

1) In D&C manager activate Drafting Standards → Tools → Labeling → DP 
Sta Elev or with the T.D.O.T. Roadway Design Division interface choose drop 
down option TDOT → Profiles → DP Profile Sta Elev w/Tracking. The 
Data Point Profile Station Elevation dialog appears.  
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Before use, the GEOPAK profile cell must be identified. Click the Identify 
Profile Cell button and select any part of the desired profile cell. 

 

2) Click the Dynamic Tracking button to initiate the dynamic mode.  Move the 
cursor off the dialog and a temporary label will follow the cursor with the station and 
elevation values changing dynamically on the screen and within the dialog’s text 
boxes as the cursor moves along the profile. 
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11. Proposed Profile Re-Design 
After the review of our design using Port Viewer in the last exercise, we know we 
have a problem with our slopes encroaching on a cemetery near station 336+50. To 
solve that problem in this exercise, we will adjust our proposed vertical alignment 
profile. 

NOTE:  
If you run into similar situations on your project, any number of changes may be 
necessary to solve the problem, adjustment of horizontal or vertical design, side 
slopes or even typical section widths in some cases. 

11a. Profile Adjustment 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager. 

2) Select the Vertical Alignment button from the Project Manager workflow 
dialog. 

3) All of the information in the invoked Settings dialog should be automatically 
populated based upon the information we defined in the working alignment. Click 
the OK button to accept those settings. 

4) From the Profile Generator dialog, select File → Load Profile.  
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Load the proposed profile 
SR95. 

5) Traverse to the VPI Station 333+50. (Utilize the Next button) 

6) Modify the current elevation from 816.50 to 822.00. Change the vertical curve 
length to 1000. 

 

7) Go to File → Save Profile and save this updated profile as SR95. You should 
get a message box stating that SR95 has been redefined. 

              

NOTE:  
The Redefine option in COGO must be turned on to make changes to a profile 
since it is stored in the GPK file. If you receive an error saying that 
Redefine is off, simply open COGO, turn it on and go back to Profile 
Generator to save your update. It is recommended that you normally 
keep Redefine turned off to avoid accidental over writing of valid 
data. 
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8) Close the Profile Generator dialog.  When prompted to save your profile, you can 
answer No since we did it in Step 7. When prompted to save your Vertical 
Alignment Settings, answer Yes. 

9) Now that we have a finalized proposed vertical alignment profile, open COGO to 
review it. 

10) Go to COGO Navigator → Profiles. Highlight SR95 and click on the 
describe icon. Profile data is displayed including curve lengths, K values and any 
high or low points. 
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11) To find specific elevations along the proposed profile for side road connections, etc. 
or perhaps a listing of elevations at 50’ intervals click on the Profile Elevation 
icon. 

 

12) The following dialog is opened. Set profile SR95, Even Stations and 50 for the 
Even interval. Begin and end stations default to the profile limits but can be adjusted 
to limit the area to report on. Click on Compute Elevation. 

 

The elevations are computed and displayed in the COGO output area. 

 

13) Close COGO. 
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11b. Re-drawing the Proposed Profile 
On longer profiles in normal workflows, you would delete the area which was 
changed and in the Profile display controls specify the station limits of revised profile 
for re-display. In this exercise, we will just delete the entire profile and re-display. 

1) Delete the proposed profile graphics for SR95 which we displayed previously. 

The proposed profile line work and text are in 2 separate graphic groups. Turn on 
the graphic group lock to easily clean off the graphics.  They are plotted on the 
following levels.  

DESIGN - PROFILE – Proposed 
DESIGN - PROFILE - Proposed Curve Text 
DESIGN - PROFILE - Proposed Text 

DO NOT delete the existing ground, profile grid or the horizontal and vertical axis 
labels. 

2) Access the D&C Manager. 

3) Select the item  
Drafting Standards → Roadway Vertical Alignments → VA Roadway. 

 



  

11-6   Proposed Profile Re-Design GEOPAK Road Course Guide 

4) Press the Draw Plan & Profile button. 

5) Click on SR95 to plot the proposed profile line work using the parameters as 
shown in the following dialogs. All items should be set automatically.  

           

Click OK to place the graphics. 

6) Exit the Draw Plan and Profile dialog. 

7) We also need to run VA Labeler again to place annotation. Double-click on the 
Item Drafting Standards → Roadway Vertical Alignments → VA 
Labeler 

Click on the Identify Profile Cell command button and data point on the 
Geopak profile cell for the profile. 

Set the Profile option to SR95. 

Click on the Place Labels command button to place the vertical alignment 
annotation. 

8) Review the new proposed vertical alignment graphics.  

9) Close the VA Labeler dialog and exit D&C Manager. 
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12.  D&C Manager – Element Symbology 
We have used D&C Manager to display chains and profiles as well as to access 
special programs. In this exercise, we will demonstrate its use to control symbology 
when drawing in MicroStation. At the same time we will demonstrate the use of 
another GEOPAK tool, Draw Transition. 

We will be drawing the edge of roadway pavements (traveled way) as well as other 
line work for the S.R. 95 roadway. These lines are needed for our plans but they will 
also control certain widths on our proposed cross sections when we re-run them. 

12a. Edge of Roadway Pavement 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Proposed.dgn  

Access Project Manager. 

2) Open MicroStation’s Reference File dialog and turn off all references except for 
the alignments DGN file (logical name: alignment). You should only see slope lines 
and the centerline. Go ahead and delete the slope lines (they are a graphic group). 
Once we fine tune our roadway a little more, we will re-run our cross sections and 
generate new slope lines. 

3) From the Project Manager dialog, select Plan View Design to open the Plan 
View Design tool box and access D&C Manager. 

Select the item Drafting Standards → Roadway Linework → EOP Prop.  

4) Check the selected icon at the top of the dialog. Ensure that you are in the Design 
mode of Design and Computation Manager. 
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5) Switch the dialog to Tool Box Mode (in expanded mode click on the first icon).  

 

Tool Box Mode tool bar 

 

Activate the toggle for Place Influence. In tool box mode this is the check box 
on the left.  

 

In expanded mode you can find it on the secondary dialog.  

 

NOTE:  
Place Influence forces all graphic elements which are created to match the selected 
item’s symbology and can be used with MicroStation’s Change Element tools to 
change existing elements. When running D&C Manager in expanded mode, the 
New Element Only option will restrict that functionality to affect only elements 
that are created.  

6) From the Plan View Design tool box, select the Draw Transition tool.  
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This will access the Draw Transition dialog. 

 

This tool is also available from the Plans Prep & Quantities task group under 
the Horizontal Plans Preparation tools when running Civil Workflows. 

 

Station 287+00 to Station 316+75 
7) Set the chain name to SR95. 

To draw the left inside edge of pavement at an offset of -24 from Station 
287+00 to 316+75, fill out the dialog as shown and press Draw. 
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8) To draw the right inside edge of pavement from Station 287+00 to Station 
316+75, fill out the dialog as shown. Notice that the only difference is the offset, 
simply remove the negative signs and press Draw. 

 

9) To draw the outside edge of pavements from Station 287+00 to Station 
316+75, repeat Steps 7-8 with 48’ offsets. Remember to use negative signs with 
numbers for offsets to the left. 

Station 316+75 to Station 327+75 
10) To draw the left inside edge of pavement from Station 316+75 to Station 

327+75, fill out the dialog as shown and press Draw. 
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NOTE: 
The area from Station 316+75 to Station 328+25 is where we are 
transitioning from the 4 lane depressed median typical to the 5 lane 
urban typical and is reflected by the offsets which vary. The pavement transition 
actually ends at 327+75 allowing an additional distance to transition the finished 
grade location from the inside edge of pavement to the crown of the roadway. We 
will discuss this further when we set up superelevation for the roadway. 

 

11) To draw the right inside edge of pavement from Station 316+75 to Station 
327+75, fill out the dialog as shown and press Draw. 

 

Use MicroStation’s Place Arc command to add an ending “nose” to the ends of the 
inside edge of pavements at station 327+75 (Radius = 6’). 
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12) To draw the left outside edge of pavements from Station 316+75 to Station 
327+75, fill out the dialog as shown and press Draw.  

 

13) To draw the right outside edge of pavements from Station 316+75 to Station 
327+75, fill out the dialog as shown and press Draw. 
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Station 327+75 to Station 347+50 
14) To draw the left edge of pavement from Station 327+75 to Station 347+50, 

fill out the dialog as shown and press Draw. 

 

15) To draw the right edge of pavement from Station 327+75 to Station 
347+50, fill out the dialog as shown and press Draw. 

 



12-8   D&C Manager – Element Symbology GEOPAK Road Course Guide 

12b. Shoulders and Curbs 
Station 328+25 to Station 347+50 

We need to add shoulder lines and linework for 6-30 curb & gutter in the urban 
section of the job and we can do so continuing with D&C Manager and the Draw 
Transition tool.  

For this exercise, we will ignore side road breaks that would be needed on this 
project. 

1) In D&C Manager, select the item Drafting Standards → Roadway Linework 
→ SHLD Prop  

 

2) Our shoulders in the urban section are 10’ wide so to draw the left shoulder from 
Station 328+25 to Station 347+50, fill out the Draw Transition dialog as 
shown and press Draw. 

 



Exercise 12 

GEOPAK V8i (SELECT Series 2) D&C Manager – Element Symbology    12-9 

3) To draw the right shoulder from Station 328+25 to Station 347+50, fill out 
the dialog as shown. Notice that the only difference is the offset, simply remove the 
negative signs and press Draw. 

 

4) To draw the curb lines we will need to go back to D&C Manager. Select the item 
Drafting Standards → Roadway Linework → Prop. Curb & Gutter → 6-
30 C&G. Notice this is in a subcategory of Roadway Linework so you have to set 
the sub-category first and then the item. 

 

5) To draw the left curb line from Station 328+25 to Station 347+50, fill out the 
dialog as shown and press Draw. 
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6) To draw the right curb line from Station 328+25 to Station 347+50, fill out 
the dialog as shown. Notice again that the only difference is the offset, simply 
remove the negative signs and press Draw. 

 

7) Curb lines use custom line styles and are built with the lower line as the curb face. 
Since this is the case it will be necessary to reverse/flip the direction of the right curb 
line so that it appears correctly. That is easily done with MicroStation’s Change 
Direction command. 

Go to the drop down menu option TDOT → Custom Line Styles → 
Reverse/Flip Pattern. 

 

You are prompted select the element and to click the direction handle to change the 
direction. Click on the red arrow to reverse the line and once more to accept the 
new direction. 
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NOTE:  
If you do not see the TDOT drop down options from the MicroStation menu bar the 
TDOT interface has not been activated. Go to File → Close and in MicroStation 
Manager set the interface option to TDOT. Re-open the DGN file and the TDOT 
options should now be available.  

8) Alternate methods of getting the Reverse/Flip Pattern custom line style tool are 
from D&C Manager or from the TDOT Roadway Design Division tool strip. Most 
options under the drop down menu are available through D&C Manager. The TDOT 
drop down menu and the TDOT Roadway Design Division tool strip are provided so 
that commonly used tools are more accessible. 

It is found in D&C Manager at Drafting Standards → Tools → Custom Line 
Styles → Flip LineStyle. To activate the Reverse/Flip Pattern tool with D&C 
Manager in tool box mode click on the Execute Design Keyin icon. In the 
expanded dialog mode double click on the item as illustrated in previous exercises. 

 

The TDOT Roadway Design Division tool strip itself can be opened from the drop 
down menu at T.D.O.T. → Tools → Design Division Tool Strip or from D&C 
Manager at Drafting Standards → Tools → Design Tool Strip. To activate 
the Reverse/Flip Pattern tool click on the Custom Line Style Tools and 
choose the 2nd option as shown. 

 

The Custom Line Style Tools can be opened as its own tool box if you are in 
the process of cleaning up several instances of custom line styles. Reverse/Flip 
Pattern is the center icon. 

 



12-12   D&C Manager – Element Symbology GEOPAK Road Course Guide 

12c. Guardrail 
Station 289+00 to Station 292+50 

It has been determined that we need guardrail on the left from Station 289+00 to 
Station 292+50. A Type 13 terminal is required at 289+00 and a Type 38 terminal is 
required at the 292+50 end so we need regular guardrail from 289+00 to 292+12.50. 

1) Access the D&C Manager. 

2) Select the item Drafting Standards → Guardrail → GR Single Prop.  

 

3) To draw the guardrail from Station 289+00 to Station 292+12.50, fill out the 
Draw Transition dialog as shown and press Draw. 

 

4) Click on the Place Influence option box to turn it off. The programs we use to 
place the guardrail terminals will be placing multiple graphic elements for us and will 
handle the symbology settings. 

NOTE:  
It is recommended that you always turn off Place Influence when you don’t 
need it. This is a powerful function and you may accidentally change graphics 
without meaning to.  
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5) Special guardrail placement programs accessed through D&C Manager utilize 
MicroStation commands to place graphics, so the custom linestyle Scale Factor 
must be set in the MicroStation Line Styles dialog.  

From the MicroStation drop down menu, go to Element → Line Styles → 
Custom and make sure the Scale Factor is set to 50. 

 

NOTE: 
When using D&C Manager’s Place Influence to draw linework with custom linestyles, 
the scale is controlled by the setting for Scale Factor under Settings → Design 
from D&C Manager’s drop down options. This can only be accessed with D&C 
Manager in expanded mode.  
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The default value for both of these locations in English files is 50. 
The only exception to this is for cross section DGN files where the 
MicroStation setting is 10. 

6) Now we need to place our terminals. First zoom in on the area from 289+00 to 
292+12.50 where we placed our guardrail run so that the ends are visible. 

Station 289+00 is the trailing end of this guardrail and this is a roadway with a 
median so we need to place a Type 13 terminal there. Go to D&C Manager and 
select item Drafting Standards → Guardrail → GR Term Type 13. Click 
on the Execute Design Keyin icon. 

7) You are prompted for a job no. Key in 101 and click OK. 

 

8) You are then prompted for the chain name. Key in SR95 and click OK. 

 

9) You are then prompted for the terminal location in the guardrail run, Begin or End 
and Left or Right. Our location is on the left at the beginning so pick Begin_Left 
from the list box and click OK. 
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NOTE:  
Begin or End and Left or Right are based on the guardrail in relation to the 
alignment’s direction and orientation. 

 

10) Finally you are prompted to Snap & Data terminal location.  Snap and 
Data Point on the guardrail at 289+00.  

 

11) Now, we can place the Type 38 terminal at the other end. Go to D&C Manager and 
select item Drafting Standards → Guardrail → GR Term Type 38 and 
click on the Execute Design Keyin icon 

12) You are prompted for a job no. Since we have just used a similar tool, it should 
default to our previous entry. Key in 101 if necessary and click OK. 

 

13) You are then prompted for the chain name. Key in SR95 if necessary and 
click OK. 
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14) You are then prompted for the terminal location in the guardrail run. Our location is 
on the left at the end so pick End_Left from the list box and click OK 

 

15) Finally you are prompted to Snap & Data terminal location.  Snap and 
Data Point on the guardrail at 292+12.50.  
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All graphics are placed for the Type 13 and 38 terminals. Now our guardrail run is 
complete. 

 

You may notice that line work in addition to the type 38 terminal itself was placed. 
These lines are on the level “DESIGN - TRANSPORTATION - GR Special 
Slope Limit Lines” and represent the limits of the pad required for installation of 
this terminal. When cross sections are processed, these lines are recognized by the 
software and additional widening of the shoulders will be reflected in the cross 
sections. 
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13. Superelevation 
In this exercise we will be setting up superelevation control shapes for our project. 
Most roadways have a constant offset from the centerline to where the finished 
grade is applied. A crown roadway where the finished grade runs right with the 
centerline like we have in the urban section at the end of our project uses a tie offset 
of 0. The depressed 48’ median section at the beginning of our project applies the 
finished grade at the inside edges of pavement and so the tie offset is -24 for the left 
and 24 for the right. 

In some areas the tie offset may not be a constant value but instead changes from 
cross section to cross section. That is the situation where we transition from the 4 
lane depressed median section (24’ tie offset) to the urban crown section (0’ tie 
offset). For these situations we will store special transition chains to use as 
GEOPAK profile grade lines or PGLs. These chains will reflect the transition of the 
inside edges of pavement from 24’ out down to 0’ where the urban section with turn 
lane starts. 

NOTES: 

PGL transition chains are not needed for transitioning pavement widths. Your 
pavement lines are read by the cross section criteria files and automatically handle 
all pavement width changes. 

Superelevation shapes do not have to cover the full pavement width. On side roads 
where the pavement width starts at one width then widens out as it approaches the 
intersection with the mainline you should never make the shapes wider than the 
narrowest width. During cross section processing as the pavement lines widen out 
the criteria will automatically take the cross slope specified by the superelevation 
shape and project it to the current width of the pavement lines. 

13a. Storing Transition Chains for PGLs 
Left PGL Chain 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95SEShapes.dgn 

Access Project Manager. 

2) Select the icon Coordinate Geometry button from the Project Manager 
workflow dialog. 
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3) Set visualization option to Disable Visualization. Storing a transition chain 
generates numerous points which we do not need to be displayed.  

4) If Redefine is clicked on, click it off to prevent accidental overwriting of data 
already stored in the coordinate geometry GPK database. 

5) Click on the Store Transition Chain icon. 

 

 

The Store Transition Chain tool will allow you to build a list of station ranges and 
offsets based upon a Reference Chain and connect the ranges into one chain. 

6) Complete the Transition Chain information as shown below: 

Reference Chain: SR95 

Chain Name: LTPGL (Transition for Left finished grade point) 

Beginning Point 
Name: 

DLT1 

Beginning Station: 0+00 

Taper Increment: 2.0 
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7) To build the transition table, in the lower portion of the dialog, enter the SR95 
station to begin the transition chain at, 316+75 and the distance from the reference 
chain (SR95) to the inner left edge of pavement, -24. Press the Add icon to 
include in the list box (it is the top left icon to the right of the station/offset list).  

 

8) Continue to build the transition list for the left PGL chain as shown below by entering 
the SR95 station where the median ending nose radius begins, 327+75 and the 
distance from the reference chain (SR95) to the inner left edge of pavement, -6. 
Press the Add icon to include in the list box. 
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9) Finish the transition list for the left PGL chain by entering the SR95 station where the 
urban section begins (328+25) and the distance from the reference chain (SR95) is 
0. Press the Add icon to include in the list box. 

10) Press the Store button to compute the transition chain. 

11) The required points are located along the alignment, sub-chains are formed as 
needed and the transition chain is stored. 

Review the chain LTPGL within the coordinate geometry dialog output list box. 

 

NOTE:  
The Taper Increment value used in transition chains can directly affect how Geopak 
tools that use superelevation shapes react. The response time can be slowed down 
considerably as more points are defined in these chains. The 2’ value used in this 
exercise works well for this roadway set up which has only 1 transition area. On 
projects where multiple transition areas are required then a higher value such as 5’ 
should be used.  
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The Store Chain command has a limit for the number of characters it can include in 
single command. The Store Transition Chain command takes this into account, 
builds sub-chains when needed and then combines them into the final chain. 

Right PGL Chain 
1) In the Store Transition Chain dialog update the Transition Chain information as 

shown below: 

Reference Chain: SR95 

Chain Name: RTPGL (Transition for Right finished grade point) 

Beginning Point Name: DRT1 

Beginning Station: 0+00 

Taper Increment: 2.0 

2) Since the transition is the same on the right side except for the offsets which are 
positive, you can edit the existing information in the list box as shown below for the 
chain RTPGL. 

Station/Region Offset 

316+75 24 

327+75 6 

328+25 0 
You can edit an existing item in the list box by highlighting the desired station and 
offset, modifying the value in the fields at the bottom of the dialog and then pressing 
the ‘Edit’ icon (bottom left icon to the right of the station/offset list) as shown below: 
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3) Press the Store button to compute the transition chain. 

4) Exit the Store Transition Chain dialog. Also, exit COGO and save your session in 
a subject name of your choosing. 

13b. Automated Superelevation 
Since our project has multiple pavement configurations, we’ll have to process the 
automated superelevation process for each configuration. 

Configuration 1:  4 Lane Divided 

Configuration 2: 4 Lane Divided with Median Transitioning 

Configuration 3: 5 Lane Undivided 

1) Open the MicroStation file (if not already open).  

C:\Projects\Roane\SR95PoplarCr\ROSR95SEShapes.dgn 

Access Project Manager. 

2) Select the Calculate Superelevation button from the Project Manager 
workflow dialog. 
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13c. 4 Lane Divided 
1) Create a new run called SR95a to represent the computations for the first 

configuration and press OK. 

 

Once the Automated Superelevation dialog has been invoked, the following dialog 
will be displayed: 
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2) For the upper portion of the dialog, complete as follows: 

Job: 101 (Working Alignment should set automatically) 

Chain: SR95 (Working Alignment should set automatically) 

Begin Station: 285+00 

End Station: 316+75 

Design Speed: 60 

Preference File: tennessee 

E Selection: 8% e max 

Facility: Divided 

L Selection: 4 Lane 

For the lower portion of the dialog, we will build the Left and Right side of the 
Roadway. 

Left & Right Roadway (4 Lane Divided) 
3) Set the profile from which the shapes should be computed to SR95 for the Left. 

Click on the Right tab to set it there as well. 

 

4) Click on the Quick Entry icon near the bottom on the right. Fill in the roadway 
data as shown and click OK. 
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5) All lanes are set up for the left and right sides of the roadway.  

The inside lane is identified as Dependent which indicates that its elevation control 
comes directly from the profile SR95. If this is not clicked on as is the case with the 
outside lane it indicates that it is Independent and gets its elevation control from 
the adjoining shape rather than the profile. 

 

 
6) Enter the Input Filename, 4lanesupers.inp, at the bottom of the dialog to store 

the computed superelevation transition commands for this station range. 

7) Press the Generate Superelevation Transitions button to initiate the 
calculation of the transitions for the Left and Right roadway within the defined station 
range. The input file is created and opened automatically in the GEOPAK Text 
Editor. 

Review the computations within the Text Editor dialog. 
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NOTES:  
Transition stations and rates should always be reviewed for errors, 
etc. 
Notice at the top of this input file that at the same time the input file was generated, a 
special report “log” file with the same name was generated. If problems occur with 
transitions, that log file should be reviewed for information on the rates and transition 
lengths which were applied. 

If needed these transitions can be edited or if needed additional cross slope 
transitions can be added such as when transitioning to existing cross slopes at final 
roadway tie-ins. 

8) To build the superelevation shapes into the graphics file, press the Autoshape 
Builder icon within the Text Editor dialog. 

 

This will automatically draw the shapes into your design file. 
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9) Close the Text Editor dialog as well as the Automated Superelevation dialog. When 
prompted to Save Superelevation settings, press Yes. 

 

13d. 4 Lane Divided with Median Transitioning 
Next, we will create a new Run to calculate and build the shapes for Configuration 2 
which is the transition from a 4 lane depressed median to a 5 lane curb and gutter. 

1) Select the Calculate Superelevation button from the Project Manager 
workflow dialog. 
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2) Create a new run called SR95b to represent the computations for the second 
configuration and press OK. 

3) For the upper portion of the dialog, complete as follows: 

Job: 101 (Working Alignment should set automatically) 

Chain: SR95 (Working Alignment should set automatically) 

Begin Station: 316+75 

End Station: 328+25 

Design Speed: 60 

Preference File: tennessee 

E Selection: 8% e max 

Facility: Divided 

L Selection: 4 Lane 

For the lower portion of the- dialog, we will build the Left and Right side of the 
Roadway. 

Left Roadway (Transition Area) 
4) Set the profile from which the shapes should be computed to SR95. 

5) Set the Tie option to PGL Chain. The PGL Chain should be set to LTPGL for the 
left transition chain. 
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6) Since our tie offset to the centerline is not constant in the transition area, we will 
have to use the manual method instead of Quick Entry to set up our lanes. 

Click on the New Lane icon to the right, near the bottom of the Automated 
Superelevation dialog. The settings for normal cross slope and lane width are 
remembered from our previous run.  

 

Since we are using a PGL chain the offsets for the super shape are from the PGL 
chain not the roadway chain as it was in the previous set up so the values of 0 and  
-12 are correct and do not need editing. 

 

We are in a transition here so we will only set up the 1 lane. When we re-run our 
cross sections, the criteria files will take the cross slope and project them to the edge 
of pavement to maintain the correct pavement widths. 
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Right Roadway Transition Area) 
7) Repeat steps 5 & 6 for the Right tab (Right roadway) using the PGL chain 

RTPGL. 

 

8) Enter the Input Filename, Transsupers.inp, to store the computed transitions for 
this station range. 

9) Press the Generate Superelevation Transitions button to initiate the 
calculation of the transitions for the Left and Right roadway within the defined station 
range. 
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Review the computations within the Text Editor dialog. 

 

10) Click the Autoshape Builder icon to build these shapes into the graphics file. 

 

11) Close the Text Editor dialog as well as the Automated Superelevation dialog. When 
prompted to Save Superelevation settings, press Yes. 
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13e. 5 Lane Undivided 
Next, we will create a new Run to calculate and build the shapes for Configuration 3 
which is a 5-lane curb and gutter section. 

1) Select the Calculate Superelevation button from the Project Manager 
workflow dialog. 

2) Create a new run called SR95c to represent the computations for the third 
configuration and press OK. 

3) For the upper portion of the dialog: 

Job: 101 (Working Alignment should set automatically) 

Chain: SR95 (Working Alignment should set automatically) 

Begin Station: 328+25 

End Station: 347+89.04 

Design Speed: 50 

Preference File: tennessee 

E Selection: 4% e max 

Facility: Undivided 

L Selection: 4 Lane 

4) For the lower portion of the dialog, we will define as follows: 

Profile: SR95 

Tie: Offset 

Offset: 0.0 



Exercise 13 

GEOPAK V8i (SELECT Series 2) Superelevation   13-17 

5) Since the tie offset is constant here, we will use the Quick Entry method again to 
populate the shape list box. 

Click on the Quick Entry icon on the Automated Superelevation dialog box. 

6) Complete the dialog as shown for the 5 Lane section 

 

7) Press OK and review that the Left and Right Tabs have been completed to cover 
the entire pavement left and right of the centerline and profile. 

 

8) Enter the Input Filename, 5lanesupers.inp, to store the computed transitions for 
this station range. 
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9) Press the Generate Superelevation Transitions button to initiate the 
calculation of the transitions for the Left and Right roadway within the defined station 
range. 

Review the computations within the Text Editor dialog. 

 

10) Click the Autoshape Builder icon to build these shapes into the graphics file. 
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If Fill is turned off under View Attributes, you can see where super 
shapes/transitions begin and end as well as the superelevation rates which the 
shapes will apply. 

 

11) Close the Text Editor dialog as well as the automated superelevation dialog. When 
prompted to Save Superelevation settings, press Yes. 
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Notes on Replacing Superelevation Shapes 
If any change is made to the chain on which superelevation shapes are based, you must 
re-create the shapes. 

It is often necessary to adjust the proposed profile. If this is done and the name of the 
profile is changed you must update the superelevation shapes. There are tools you can 
use to do this but due to the number of shapes usually encountered this method is 
problematic at best. It is highly recommended that you avoid changing the 
profile name if at all possible. You can save the current profile under a different 
name that can be saved back to the original name if you decide to throw out the profile 
change. If you do change the profile name then just re-create the shapes rather than trying 
to edit them. 

For these and other reasons it may be necessary to delete superelevation shapes for a 
roadway and re-create them. When you do this, always compress the MicroStation 
DGN file afterwards so that GEOPAK cannot read deleted invalid superelevation shape 
graphics. 
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13f. Shape Manager Tools 
Several tools are available to get information from or to check superelevation shapes. The 
following sections describe some of the more useful of these. Review our graphical 
superelevation shapes with the following tools before we re-run our proposed cross 
sections. 

The Superelevation Shape Manager tools are available in the Road Tools task 
group when running Civil Workflows or you can invoke the tool box from the MicroStation 
menu bar drop down option Applications → GEOPAK → Road → Cross Sections 
→ Superelevation Shape Manager Tools. 

You can right click within the tasks to open it as a 
separate tool box as well. 
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Shape Analyst  
The Shape Analyst tool is extremely useful, as it provides information on any point 
within a GEOPAK superelevation shape. 

1) Select the Shape Analyst icon to invoke the following dialog. 

 

 

While most of the dialog is displayed information, some user input is required, and 
detailed below. 

Job Number 

Coordinate geometry database number, wherein superelevation chains and profiles 
are stored. The Job Number can be manually entered or identified by pressing the 
Select button. 

Display Only 

When active, the flow arrow and text are displayed, and not drawn into the 
MicroStation design file. Therefore, they are lost when the screen is refreshed. 
When not active, all text and elements are placed in the MicroStation file. 

Cross Section 

When the toggle is not activated and a data point is issued within a shape, the 
elevation of the data point and a flow arrow are displayed. 
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When the toggle is activated, a dashed line is placed through the data point, 
perpendicular to the shape cluster baseline. In addition to the elevation and flow 
arrow placed at the data point, elevations are displayed where the cross section line 
intersects any superelevation shape. 

2) Provide the Job Number 101 and Chain SR95 to complete the required definitions. 

3) Press the DP button and select an area within a superelevation shape and review 
the information as shown below in the dialog. 

 

NOTE:  
The preferences to control the display information reflected by the superelevation 
shape may be set via the Shape Analyst dialog by selecting User → 
Preferences. There you can control the display of the arrow as well as slope and 
elevation text. 

4) Click Display Only on and then press the Dynamic button to track across a 
transition area to observe the cross slopes changing along the roadway. 
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5) Close the Shape Analyst dialog. 

Shape Properties 
The Shape Properties tool is useful for checking as it provides information on any GEOPAK 
superelevation shape. In addition, this shape information can be modified on individual 
shapes or selections of shapes. 

1) Select the Shape Properties icon to invoke the following dialog. 
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Three action buttons are supported at the bottom of the dialog.  

To populate the activated shape parameters with the attributes of a particular shape, 
press the ID button, then select and accept a GEOPAK superelevation shape. 
GEOPAK populates every field where a toggle is activated.  

To set a particular GEOPAK superelevation shape with a set of desired parameters, 
activate the desired parameters and populate the associated fields with the 
desired values. Then press the Set button, select and accept the superelevation 
shape to be changed.  

If multiple shapes need to be changed, activate the desired parameters and 
values, define a MicroStation selection set to include the shapes to be changed and 
then press the Set Entire Selection button.  

2) Activate the following toggles:  

Baseline 
Profile 
PGL Chain 
Tie 
Class 
From Slope 
To Slope 

3) Press the ID button and then select a graphical superelevation shape. 

Review the properties of the selected shape. 
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4) Close the Shape Properties dialog. 

Autoshape Builder 
The Autoshape builder tool icon you may recognize from running super shape input files 
earlier. When you build input files with the Automated Superelevation dialog this icon is 
added to the GEOPAK Editor so that you can run the input file from there. 

 

What you can do with the icon from this location is run an input file for super shapes without 
going through the Automated Superelevation dialog. You can take an input file generated 
earlier, open it up and make some changes to transitions or whatever and then use this tool 
to build the shapes. 

The Display Only option allows you to test run the input file without actually writing the 
superelevation shape graphics to the file. 

The Override Input File Level Symbology option allows you to supersede the 
definitions specified for the shape’s level, color, weight and style in the input file. Double 
click on the symbology preview boxes to open up Set Feature dialogs to set these alternate 
values. 

 

This can truly be helpful in areas where special conditions require 
extensive non-standard superelevation transition settings which may end 
up being adjusted multiple times to come up with a design that will work. 
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13g. Working Alignment - Define Shapes 
We are completing the Plan View of the Working Alignment Definition in Project 
Manager. 

1) From the Workflow dialog of Project Manager, press the Define button. 

2) Highlight the Plan View → Shapes option and populate the Shapes Design file 
as shown below: 

 

NOTE:  
If you place super shapes for multiple roadways in the same DGN file it will be 
necessary to set up By Search Criteria for this setting instead of All in DGN. We 
recommend using different levels to separate them. This allows for easy isolation of 
the graphics in the event that one set may need to be replaced. 

3) Press the OK button to save the updates and close the dialog. 

 



Exercise 14 

GEOPAK V8i (SELECT Series 2) Proposed Cross Sections – Final   14-1 

14. Proposed Cross Sections – Final 
Now that we have adjusted our profile, added edge of pavement lines to control 
pavement widths and set up superelevation shapes to apply superelevation to the 
pavement and shoulders, we are closer to producing finalized cross sections. 

In this exercise, we will apply our superelevation shapes and take this one step 
further by setting up some special controls for side slopes as well as the application 
of a special ditch ultimately leading to the final cross sections for S.R. 95. 

14a. Initial Set up 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

2) Prior to beginning the process of the final proposed cross section design, we need to 
delete our preliminary sections but we want to leave on our cross section grids so 
they will not have to be placed again. 

From the Menu Bar in MicroStation, use the following pull down tool to remove your 
proposed cross sections: 

T.D.O.T. → Cross Sections → Delete ALL Prop. XS Graphics 

NOTE:  
This tool is also available from D&C Manager at  
Drafting Standards → Cross Sections → Delete XSs 

3) Access Project Manager. 

4) Choose Proposed Cross Sections from the Project Manager workflow 
dialog. 

Since most of settings we made in the preliminary run will still be valid for our final 
cross sections, in the Select Run dialog go to Run → Copy → Run and make 
a copy of the run Prelim and call it Final.  

Open run Final. 
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5) In the Proposed Cross Section dialog, go to Shapes. First set the control button to 
All in DGN and then click on Use Working Alignment Definition. 

 

14b. Define Roadway/Shape Clusters 
Add Shape Clusters 
1) Next, select the Shape Clusters item. 
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We can now see the clusters as we set them up originally in the Prelim run. Notice 
that since we have activated superelevation shapes in the previous step, a Scan 
button has been added to the upper right of the dialog to search for shape clusters. 

2) Press the Scan button to invoke the following dialog. This list reflects all of the 
superelevation shape clusters specified by our working alignment definition. 

 

We can see that some of the clusters correspond with what we have already set up 
for Prelim but we do need to add the clusters for the transition area which utilize the 
special PGL chains. 

3) Highlight the cluster, Chain = SR95, Tie/PGL = LTPGL, Profile = SR95 in 
the list. When you do this, it will be used to fill in the Chain, Tie and Profile fields in 
the main dialog. 

Press the Add button to add the cluster to the processing list. 
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4) Repeat Step 3 to add shape cluster Chain = SR95, Tie/PGL = RTPGL, 
Profile = SR95 clusters.  

Press the Close button on the List of Clusters dialog to dismiss it when done. 

Your main dialog should now appear as shown. 
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NOTE:  
The order of the shape clusters does not matter so you do not have to use the Up 
button to re-organize them. 

One important concept to remember is that you should never have more than 
one shape cluster specified in this list with the same set of 
parameters. If you do this, all but the last one will be ignored and not processed. 
Instead, under the Side Slope Conditions, you will have multiple station ranges. 
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Shape Cluster Station Adjustment 
5) Highlight shape cluster Chain = SR95, Tie/PGL = -24, Profile = SR95  

Originally we set this cluster up to go all of the way to the beginning of the urban 
section at station 328+25. Now that we have special shape clusters for the transition 
area, we need to edit the final station given for this cluster and its corresponding 
right roadway cluster at the Tie of 24. 

In the Side Slope Condition area, highlight the Side Slope LT condition ending at 
328+25 and press the Modify button to access the Side Slope Modification dialog. 
Change the ending station to 316+75 (beginning of our PGL transition): 

 

Click OK to save the change and return to the main dialog. 

6) Repeat step 5 for the Side Slope RT condition. 

 

7) Highlight shape cluster Chain = SR95, Tie/PGL = 24, Profile = SR95. 
Repeat steps 5 & 6 for its LT & RT side slope conditions. 
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Shape Cluster: Chain=SR95,Tie/PGL=LTPGL,Profile=SR95 
8) This cluster represents the left side transition area of our lane divided roadway 

section. Highlight the cluster in the list box and press the Typical button  

NOTE:  
Even though we are transitioning down from the full 4 lane divided roadway section, 
we will continue to use the same typical. Its criteria files are set up to recognize 
transition areas and to alter medians, etc. as needed. 

9) From the typical section List, select the Typical Section “4LNDMD – 4 LANE 
DEPRESSED MEDIAN”. 

 

10) Since this shape cluster represents the left side of our transition, we need to apply 
the Typical Section to the left roadway. Set the toggle as shown. 
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Also, since our shape cluster runs from Station 316+75 to Station 328+25, we 
need to apply the Typical Section to that station range. 

 

Once station range is set, press Apply. 

The Typical Section Generator will then populate the main dialog with the required 
Side Slope conditions and associated criteria files.  

 

Shape Cluster: Chain=SR95,Tie/PGL=RTPGL,Profile=SR95 
11) This cluster represents the right side transition area of our lane divided roadway 

section. Repeat steps 8-10. Apply the Typical Section to the Right Roadway 
and use a station range of 316+75 to 328+25. 
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14c. Define Variables 
Next, we’ll need to re-define our variables as needed. Variables allow us to 
customize our cross sections. For example, on one project our “Subgrade Depth” 
may be 1.5’, while on another it may be 1.75’. Or we may want to set up different 
runs on the same project where each run reflects differing variable values. 

NOTE:  
Once a value is set, that value controls the entire cross section run. For example, if 
we set the “Subgrade Depth” to a value of 1.5’, our subgrade depth will be plotted at 
1.5’ for all of the cross sections. 

1) Select the Define Variables item from the Proposed Cross Section dialog list 
box. Most of our variables are already set but we want to make a couple of changes. 

2) Select the Variable “Place XS Grid?” and set the Value to “N”. To do this, 
enter the change in the Value field and press the Modify button. 

 

3) Select the Variable “subgrade depth” and set the Value to “1.75”. 
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14d. Variable Criteria Files 
All of the rest of the settings in our run Final are set so we could run our cross 
sections to see what effects our changes have made but instead let's take this fine 
tuning of our roadway one step further. 

By default, our side slopes are variable and are based on Case I or Case II slope 
criteria as specified on T.D.O.T. standard roadway drawing RD01-S-11. In certain 
situations, we may be required to adjust this in certain areas with fixed slopes, 
special ditches or benching. 

We will illustrate how to address some of these in this section by setting up some 
special re-definable variables in our variable criteria files. Re-definable variables are 
variables which are set up so that we can vary their values by station range.   

Re-definable controls are available for: 
Fixed Fill or Cut Slopes on left or right 
Maximum cut or fill slope control to limit maximum slopes applied using normal 
variable slopes application 
Median slopes in guardrail areas for bridge pier or bridge end protection 
Special ditch application area: 
 along roadway 
 at the toe of fill slopes 
 at the top of cut slopes 
Special ditch defined by: 
 centerline & profile (channel changes) 
 profile and foreslope 
 minimum depth and foreslope 
Berm control for top of cut special ditches 
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Low water keyhole for channel change special ditches 
Benching in earth or rock cuts and earth fills 
Bench formation defined as: 
 single slope to top of rock  
 repeating by height 
 up to 6 defined elevations 
Benching Rock- Earth interface area defined as: 
 bench at rock 
 trace rock 
 single slope 
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Special Design Case 1 – Rural Fixed Slopes 
To limit the length of box culvert required at Poplar Cr., we need to steepen slopes 
behind the guardrail on the left side of the roadway from Station 289+00 to Station 
292+00.  

Fixed Fill Slope Left: 2:1 

We need to pull slopes inside present R.O.W. on the right side of the roadway from 
Station 293+00 to Station 297+00. 

Fixed Fill Slope Right: 3:1 

Special Design Case 2 – Special Ditch 
A special trapezoidal ditch is needed on the left side of the road from Station 300+00 
to Station 309+00 to handle a buildup in the volume of water coming down the hill. 

Elevation Control: Minimum Depth of 4’ 

Ditch Width: 6’ 

Foreslope: 6:1 

Backslope: 2:1 

Special Design Case 3 – Urban Fixed Slopes 
To minimize encroachment on properties in the urban section, it has been stipulated 
that we may use 3:1 slopes instead of normal variable slopes in that area from 
Station 328+25 to Station 347+50. 

Fixed Cut Slope Left: 3:1 

Fixed Fill Slope Left: 3:1 

Fixed Cut Slope Right: 3:1 

Fixed Fill Slope Right: 3:1 

To handle each of these situations, we’ll need to edit the appropriate variable criteria 
file. Each Typical Section has its own variable file. It can be determined by looking at 
the first criteria file name listed for the left side slope set up for any given roadway 
shape cluster. On this project they are as follows: 

Typical Section     Variable Filename 

4LNDMD (4 Lane with Depressed Median)         Var4LaneDmed.x 

5LNUS (5 Lane Urban with Shoulders)                 Varu5LaneShlds.x 



Exercise 14 

GEOPAK V8i (SELECT Series 2) Proposed Cross Sections – Final   14-13 

Rules for Variable Criteria File Editing 

The following guidelines should be observed when setting up the variable criteria file 
to alter cross sections to reflect design needs for special areas along the roadway: 

1. Comment lines are lines used for explanation only and are not 
processed as commands. They should begin with /* and end with */. 

2. If statements are statements that define an area, station to 
station, within which the commands that follow it will be processed. 

3. The begin bracket { and end bracket } signify the beginning and end of 
variable settings. The settings should follow if statements. 

For Alternate Side Slopes, Special Ditches or Benching along 
Roadway: 

1. Copy the lines of text between the lines that contain the “begin” comment 
and the “end” comment. The copying should begin with the line 
containing the “if statement” and end with the line containing 
the end bracket “}”. Make a copy for each “station to station” area 
needed.  

2. Paste these copies at the end of the file after the comment “/* Add all 
changes below this line */” 

3. For each area with different settings, 

a. Change the station ranges (and region #’s if needed) in the “if statement” 
text line. 

b. Set the variables as needed for that area on the LT or RT. 

c. If it’s for the left only, then delete the lines of text for the RT. If it’s for the 
right only, then delete the lines of text for the LT. 

When a variable file (Var***.x) is modified for use by a specific roadway it will be 
necessary to rename it (Example: VarMainline.x). That way it will not be overwritten 
or used on the wrong roadway. Once this file is modified and re-named, replace the 
original variable criteria file associated with your roadway in the GEOPAK Proposed 
Cross Section dialog with this new one. 

Any values which need to be applied on the entire roadway can be set in the 
Define Variables section of the GEOPAK Proposed Cross Section dialog. 
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14e. Variable Criteria File Editing 
1) Access the GEOPAK Text Editor from the Road Tools task group. 

 

Special Design Case 1 - Application 
2) Using the File drop down, open the variable file Var4LaneDmed.x located in 

your project directory.  Scroll down until you see the section for Alternate Side 
Slopes as shown below: 

 

The instructions for editing variable criteria files shown on the previous page are also 
given in each variable criteria file. 

3) Following the rules stated for editing this file, copy the alternate side slope section 
twice to the bottom of the file and edit this area of the variable file so that it looks as 
follows: 
if station >= 289+00 R 1 and station <= 292+00 R 1 then 
 { 
  _d_FixedFillSlopeLT = 2:1 
 } 
 
if station >= 293+00 R 1 and station <= 297+00 R 1 then 
 { 
  _d_FixedFillSlopeRT = 3:1 
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 } 

Special Design Case 2 - Application 
4) Scroll back up until you see the section for Special Ditches as shown below: 

 

5) Following the rules stated for editing this file, copy the special ditch section to the 
bottom of the file and edit this area so that it looks as follows: 

if station >= 300+00 R 1 and station <= 309+00 R 1 then 

 { 
  _d_LTDitchMinDepth =  4 
  _d_LTDitchWidth =  6 
  _d_LTDitchForeslope =  6:1 
  _d_LTDitchBackslope =  2:1 
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  _s_LTDitchInPlan =    "Y" 
 } 

6) Sometimes, GEOPAK has trouble reading the last line of a criteria file so add a few 
blank lines at the end of the file to ensure processing without errors. 

7) Using the File drop down in GEOPAK text editor, use Save As to save your 
changes as SR95Var4LaneDmed.x. 
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Special Design Case 3 - Application 
8) Since this scenario is in a section of our project covered by the typical 5LNUS, we’ll 

need to use the appropriate variable file to make our changes.  

Using the File pull drop down in GEOPAK text editor, open the variable file 
Varu5LaneShlds.x located in your project directory. Scroll down until you see 
the section for Side Slopes as shown below: 

 

9) Copy this section to the bottom of the file and edit this area of the variable file so 
that it looks as follows: 

if station >= 328+25 R 1 and station <= 347+50 R 1 then 
 { 
  _d_FixedCutSlopeLT = 3:1 
  _d_FixedFillSlopeLT = 3:1 
 
  _d_FixedCutSlopeRT = 3:1 
  _d_FixedFillSlopeRT = 3:1 
 } 
   

10) Using the File drop down in GEOPAK text editor, use Save As to save your 
changes as SR95Varu5LaneShlds.x. 

11) Exit the GEOPAK text editor. 
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14f. Re-Assigning Variable Criteria Files 
1) Return to the Proposed Cross Section dialog and under Shape Clusters select the 

Shape Cluster identified by Chain=SR95, Tie/PGL=-24 and Profile=SR95. 

 

2) At the bottom of the dialog below the Criteria File list, press Add and the following 
dialog will appear. 

 

NOTE:  
Use the Select button at the upper right of the dialog if you need to change paths 
to your project working directory. 
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3) Highlight the new variable file SR95Var4LaneDmed.x and then press the To 
Criteria button or double-click on the file to add the file to the Proposed Cross 
Section Criteria File list. 

 

4) Highlight the new variable file and press the Up as many times as needed to 
move the file to the top of the Criteria File list. 

 

NOTE: 
Since cross sections process from left to right and variables must be defined before 
other criteria files can be processed, then the variable criteria file must be first in 
the left slope condition or in some cases where there is no left slope condition, first 
in the right set up. 
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5) In the Criteria File area highlight the original variable file, Var4LaneDmed.x at the 
top of the list and press Delete.  

6) Answer Yes to the following dialog prompt and the original variable file 
Var4LaneDmed.x will be removed from the list. 

 

7) Select the Shape Cluster identified by Chain=SR95, Tie/PGL=LTPGL and 
Profile=SR95.  

8) Repeat previous steps 2-6 to add the new variable file SR95Var4LaneDmed.x 
and delete the old variable file Var4LaneDmed. 

9) Select the Shape Cluster identified by Chain=SR95, Tie/PGL=0 and 
Profile=SR95.  

10) Repeat previous steps 2-6 to add the new variable file 
SR95Varu5LaneShlds.x and delete the old variable file Varu5LaneShlds.x. 

11) We are now finished adding criteria files so can click on the Done button on the 
Add Criteria dialog. 

NOTE:  
When replacing variable files, never delete the original file first. Values that have been set 
under Define Variables will be re-initialized to their original default values so that you would 
have to set them again for your project. 
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14g. Processing Final Proposed Cross Sections 
1) At this point, we are ready to process our final proposed cross sections. From the 

Proposed Cross Sections dialog, select drop down option Files → Run. 

2) Select Screen Only and de-activate the Pause on Each Section toggle. 

Press Apply. 

3) When cross sections finish processing, close the Proposed Cross Sections dialog 
box and click Yes to save your run when prompted. 

4) Review your proposed cross sections using XS Navigator. Check the changes that 
have been made since we originally ran them including: 

• 2:1 slopes behind the guardrail on the left (289+00 - 292+00) 

• Type 38 guardrail terminal pad widening on left at 10:1 slope (292+00 – 293+50) 

• 3:1 side slopes on the right (293+00 - 297+00) 

• Special ditch on the left (300+00 - 309+00) 

• Superelevation on our 2 horizontal curves (307+74 – 323+55) (330+66 – 
337+95) 

• Transition area from 4 lane divided to 5 lane undivided (316+75 - 328+25) 

• 3:1 side slopes on left & right in the urban section (328+25 - 347+50) 

5) Open the Proposed DGN file ROSR95Proposed.dgn and review your slope 
lines in the following areas: 

• Slope ties pulled inside of existing R.O.W. on right (293+00 - 297+00) 

• Special ditch on the left (300+00 - 309+00) 

• Slope ties pulled outside of cemetery area on the right (336+00 - 338+50) 
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15 Earthwork  
Now that we have final cross sections, we can calculate earthwork for this roadway. 
In the first part of this exercise, we will go through the procedures to calculate cut & 
fill quantities where only earth is involved. In part 2, we have a set of cross sections 
pre-defined on which rock lines have been plotted and some deep cut benching has 
been developed for the roadway. We will use this data set to process some 
earthwork where multiple soil types are involved. 

NOTE:  
Several special non-roadway typical sections are available for plotting rock lines, 
topsoil lines, existing pavement or un-suitable material onto cross sections using the 
proposed cross section tool. In the typical list their names all start with P_ (for plot). 

15a. Earth Only 
1) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

Access Project Manager. 

2) Choose Earthwork from the Project Manager dialog and create a new run 
named SR95. 
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3) Populate the XS DGN File section of the dialog as shown below (most settings 
should fill in automatically from our working alignment definition): 

 

NOTE: 

The Vertical Search Distance should never be set at a value greater than 1/2 
the distance between cross sections. In our cross sections, that offset distance is 
500 feet so we use 250 feet. 

If set greater than that, it is possible graphics for one section will be read by the one 
before or after it. If your graphics go past this half way point, then cross sections will 
need to be re-generated at a larger distance apart so that the vertical search 
distance can be set at a higher value. 

4) In the Soil Types section of the dialog, create the following classifications and soil 
types utilizing the parameters detailed in the table below.  

Class Soil Type Search Criteria 

Existing Ground Earth Use Working Alignment Definition 

Proposed Finish Grade Earth Use Working Alignment Definition 

Shrink and Swell factors are set under the Multiplication Factors section. 
Factors are based on 1 so for a shrinkage of 15% you would set the value 0.85. Set 
the Multiplication Factor for Roadway Excavation with a value of 0.85. Once a 
definition is set click the Add button. 

NOTE:  
If topsoil stripping is desired under fills then you must define Excavation Limit 
lines in this section. It is the only class that is not an actual soil type. Excavation limit 
lines are placed by default at slope tie-ins on T.D.O.T. cross sections. The topsoil 
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line itself should be defined as an unsuitable material so that it would not be used as 
fill material. 

 

In our case, we are using the Working Alignment Definition to define the 
symbologies of our materials. If we were not using the Working Alignment Definition, 
we could manually define the symbologies using the settings in the Search Criteria 
portion of the dialog. When using these settings, there are also three additional 
buttons to help you. 

Match   Will prompt you to identify an element. Once you do, it will fill in the 
symbology settings with the symbology of the identified element. 

Display Will highlight all elements in the design file matching the set 
symbology. 

Reset   Will clear all symbology settings. 
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5) In the Earthwork Shapes section of the dialog, Toggle on Draw Earthwork 
Shapes and Stratify Shape Color. Double click on the symbology review 
area to open the Set Feature dialog.  

 

Populate the dialog with the parameters as shown below. The level name is 
DESIGN - EARTHWORK - Shapes 

 

6) Set the Output Format as shown below.  

 

Use the arrow buttons (< or >) to change the format to Excavation and Fill. 
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7) Skip down to the Sheet Quantity section and toggle on the Write Sheet 
Quantities File.  

Name the file SR95Earth.txt. Add the following columns to the file with 
Decimal Places = 0 and Total Quantity Length = 10.  

After setting values at the bottom, click Add to set them up in the list box. 

Col. Soil Type EW Operation Quantity Type +/- 

1 Earth Common Exc End Area + 

2 Earth Fill End Area + 

 

8) Using the Files > Run drop down option, run the earthwork for the proposed cross 
sections. Place your output into a log file as shown in the dialog below and Pause 
on Each Section. Click Apply to start processing. 
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If the Pause on Each Section is off the Disable View Update option can be used 
to eliminate view updates which will reduce the required processing time. This can 
be an excellent time saver on larger projects. 

9) You will have to skip the first few sections and the last section where there are no 
proposed cross sections. 

 

If you ever encounter a spot where it says the proposed does not tie with the 
existing, use MicroStation’s Zoom In and click the DP button provided on the 
earthwork warning box. You will zoom in on the problem spot. If it is between 2 
proposed cross section elements, check their symbology to make sure they are 
correct. If it is at the ground tie in, check to make sure they do in fact intersect. 

You should never use the Skip button shown above in bridge or other areas where 
you do not want earthwork. Instead use Skip Areas & Ignore Areas as described 
later in this chapter. 

10) After reviewing the first section at 287+00, turn off the Pause On Each Section 
option and click Continue. 
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11) When processing is complete, exit the Earthwork dialog and save your run. 

12) Review the file SR95earth.log using the GEOPAK Text editor. Grand totals and 
Balance points are listed at the end of the report. 
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NOTE:  
The log file is the earthwork documentation to be submitted with plans when turning 
a job in for construction. This file can be printed on letter size paper from 
NOTEPAD in landscape mode. 

13) Review your cross sections using XS Navigator. Notice that GEOPAK has placed 
shapes onto your cross sections representative of the calculated earthwork areas. 
These shape areas can be measured to verify earthwork areas if desired. Turn fill on 
to see where cuts and fills are. 

 

15b. Earth with Rock 
In the second part of this exercise, we’ll compute earthwork for a dataset containing 
rock. To save time going through this exercise, we have already plotted rock lines in 
on the cross sections.  

1) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\RockEarthworkXS.dgn 

Access Project Manager. 

2) Choose Earthwork from the Project Manager dialog and create a new run 
named SR95rock. 

3) Populate the XS DGN File section of the dialog as shown below: 
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4) In the Soil Types section of the dialog, create the following classifications and soil 
types utilizing the parameters detailed in the table below. 

Class Soil Type Search Criteria 

Existing Ground Earth Use Working Alignment Definition 

Proposed Finish Grade Earth Use Working Alignment Definition 

Existing Suitable Earth Toggle on Level, Style & Weight 
Reset then Match Top of Rock line 

Existing Suitable Rock Toggle on Level, Style & Weight 
Reset then Match Bottom of Rock line 
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For the Rock soil type, set the Roadway Excavation Multiplication Factor 
to 1.2 (20% swell). 

For the Earth soil types, set the Roadway Excavation Multiplication Factor 
to 0.85 (15% shrinkage). 

NOTE:  
The most important concept to pick up as you set these Soil Types is that any lines 
found beneath the top of existing ground define the limits of the soil type 
above them. 
In the example we are working, the top of the rock is specified as soil type Earth 
which is the soil type above that line. 
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5) In the Earthwork Shapes section of the dialog, Toggle on Draw Earthwork 
Shapes and Stratify Shape Color. Double click on the symbology review 
area to open the Set Feature dialog.  

 

Populate the dialog with the parameters as shown below. The level name is 
DESIGN - EARTHWORK - Shapes 

 

6) Change the Output Format as shown below.  
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7) Skip down to the Sheet Quantity section and toggle on the Write Sheet 
Quantities File. 

Name the file SR95Rock_Earth.txt. Add the following columns to the file with 
Decimal Places = 0 and Total Quantity Length = 10. 

Col. Soil Type EW Operation Quantity Type +/- 

1 Earth Common Exc End Area + 

2 Rock Common Exc End Area + 

3 Earth Fill End Area + 

 

8) Using the Files → Run drop down, run the earthwork for the proposed cross 
sections. Place your output into a log file as shown in the dialog below and click 
Apply to start processing. 
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9) Exit the Earthwork dialog and save your run. 

10) Review the file SR95rock.log using the GEOPAK Text editor. 

 

11) Review your cross sections using XS Navigator. You should see that rock cuts are 
figured separately from earth cuts. 
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15c. Skip Areas & Ignore Areas 
The most common use of Skip Areas and Ignore Areas is to stop earthwork 
end areas & volumes from being calculated in bridge areas. You cannot use the on 
the fly Skip option to accomplish this. If you click Skip at any station that earthwork 
processing stops, then the station is skipped but earthwork will still be calculated 
across the station which was skipped. 

This information is provided for review and reference only. 

In the Skip Areas dialog, set up the begin and end stations of the bridge as a 
skip area to control the limits of earthwork volume calculations. Cross Sections at 
these stations must be cut with the proposed roadway placed on them in the cross 
section DGN file in order for Geopak to correctly calculate the earthwork. 

 
To get GEOPAK to completely ignore the proposed bridge cross 
section stations, we must set up both Skip Areas and Ignore Areas. 
We do not need end areas calculated at proposed bridge cross sections so we also 
need to set up the Ignore Areas section of Earthwork. The station range should 
be set to the first station beyond the beginning of the bridge and the last station 
before the end of the bridge. 
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In proposed cross section runs, the station limits for the proposed bridge deck 
should be set to be greater than the begin bridge station and less than the end 
bridge station. The cross sections at the begin bridge station and at the end bridge 
station should show the proposed roadway with slopes not the bridge 
deck. The begin and end stations are used for volume calculations with the cross 
sections before and after the skipped area. 

 
When set up and processed correctly, the Skip Area station range is shown in the 
earthwork log file but the earthwork volume totals shown at the begin and end 
station of the bridge are the same. Due to the settings made in Ignore Areas, no end 
area data is given for the stations between the begin & end.  
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16. Cross Section Sheets 
In this exercise, we will take our proposed cross sections and earthwork end areas 
calculated in the last exercise and put them on sheets. 

NOTE:  
GEOPAK’s Cross Section Sheet layout tool attaches each cross section as a 
reference file. As long as no major changes in the proposed profile are made, any 
updates done to the original working cross sections will be reflected on the sheets. 

1) Open the following MicroStation file: 

 C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSSheets.sht 

NOTE:  
When creating a new cross sections sheet design file, always use the seed file 
SeedXS.dgn. This file has special settings which are different from the normal 
seed2d.dgn DGN seed file. This is required for proposed cross section design files 
and should be used for cross section sheet design files as well to ensure correct 
scaling of text, sheet cells, etc. 

Access Project Manager. 

2) Choose Cross Section Sheets from the Project Manager workflow dialog and 
create a new run named SR95. The Cross Section Sheet dialog is displayed. 
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3)  Go to the drop down option File > Sheet Library > Attach. When prompted go 
to T.D.O.T.’s Geopak Standards directory C:\Users\Public\Geopak Standards and 
load Roadway10scale.xssl. 

 

As you can see there are sheet types available for 10 or 20 scale, roadway or culvert 
cross sections for use on English projects as well as 100 or 200 scale for metric 
projects. These files make all non-project specific set up for cross section sheet 
generation. 
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4) Make sure that the XS DGN portion is filled out correctly from our working 
alignment definition. 

 

5) Under Sheet DGN use the browser button to select 
ROSR95MainlineXSSheets.sht to place our sheets in. If needed, you can set 
the sheet placement point. For this exercise, we will use 1000, 1000. Make sure 
the option Detach Existing Sheets before Processing is clicked on so that if 
you need to re-generate cross section sheets you will not have to delete old sheets. 
The Attachment option should be set to All Sheets In Active Model. 
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6) Skip down to XS Search Criteria and review the settings which should be set 
already and appear as shown. Lv Names and Types should be on.  Lv Names 
must be set using  the wild card symbol (*) due to limited field length and should be 
entered as  
Default,DESIGN - DRAIN*,DESIGN - LINE*,DESIGN - ROW - 
R*,DESIGN - TYPICAL - B*,DESIGN - TYPICAL - F*,DESIGN - TYPICAL 
- G*,DESIGN - TYPICAL - R*, DESIGN - TYPICAL - S*,DESIGN - 
TYPICAL - T*,*Tops*,*Unsuitable*,SURVEY - GROUND - T*,SURVEY - 
GROUND - E*,SURVEY - PROPERTY - R* 

 

NOTE:  
These settings are used to find cross section elements and use them to set the 
clipping limits for that cross section’s reference. The actual elements shown are 
controlled by what levels are turned on in the original cross section file at the time of 
sheet generation (cross section reference attachment). In step 12, we will go back to 
our working cross section file to make sure the correct levels are shown. 
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7) Skip down to Sheet Stack Columns and review the setting for the Baseline 
X Offset. This value is based on inches from the left side of the sheet. If you ever 
need shifted cross sections so that left or right has more coverage adjust this value. 
Our cross sections need to be centered on the sheet so we can use this as is. 

 

8) Scroll down to Earthwork Quantity Labels. Click on the browser button to 
select our earthwork text file which contains our end areas, SR95Earth.txt. 
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9) Double click on the word Sample under Display for the first item in the list. From 
our earthwork exercise we set up item 1 as cut and item 2 as fill so item 1 needs the 
prefix CUT. That is the default so we do not need to change what is set. Click OK 
to keep the current settings.  

 

10) We set up item 2 as fill so it needs the prefix FILL. Double click on the word 
Sample for the second item in the list. Again that is the default so we do not need 
to change what is set. Click OK to keep the current settings. 

NOTE:  
Our most common earthwork set up is just for earth cut & fill which are the default 
prefix settings. In other cases such as with roadways that include rock cuts or topsoil 
removal there may be additional earthwork data items. In those cases you would 
need to specify these prefixes as EARTH CUT, ROCK CUT or TOPSOIL. In some 
cases you may have special areas of fill items that might need to be specified such 
as EARTH FILL and SOLID ROCK FILL. The setting of these prefixes should be 
based on the order in which you set them up when calculating the earthwork. 

When you identify the earthwork text file it is reviewed for the number of earthwork 
data items and will automatically add controls for any additional items. In those 
cases you will need to make all of the settings to control placement location as well 
as level, symbology, etc. Use the following as a guideline when you make these 
settings: 

X Offset: 29.1   Y offset (0.2 increments): .3, .1, -.1, -.3 

Level: DESIGN - TYPICAL – Text Color: 0   Weight: 4 

Th & Tw (text height & width): 1.200 Ft (font): 3 LEROYMON Scale: 10 
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11) Go to Sheet Labels. By default roadway cross section sheets are set up to place 
project data in the upper right corner as well as a name and the cross section limits 
of the sheet in the lower right corner. If you know the project number, it could be 
entered at this point. 

 

Double click in Label field for the item YEAR, key in the current year and hit 
enter. You may wish to expand the column by clicking on the divider line in the 
header and dragging to the right. 
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Double click in Label field for the item SHEET NO, key in 50 and hit enter. 
This value is used as the beginning sheet number. 

 

Double click in Label field for the item NAME and enter S.R. 95 ROANE 
CO. and hit enter. 
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Any of the Sheet Label values can be changed in this manner. Additional items for 
annotation can be set in the lower part of the dialog and added with the Add New 
Label icon on the side of the list box. 

NOTE:  
Culvert dross section sheets are set up to place a standard title block layout in the 
lower right corner of the culvert cross section sheet. 

12) Before we generate our cross section sheets, open up file 
ROSR95MainlineXSections.dgn and use the level filter Sheets – Roadway 
Cross Sections to set the levels on in view 1, Save Settings for the DGN file 
and then re-open ROSR95MainlineXSSheets.sht. 

13) Process the cross sections onto sheets by clicking on the Layout Sheets button 
on the upper right of the Cross Section Sheet Composition dialog. 

14) Check out your sheets and if needed, make adjustments to your settings and layout 
again. 
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15) In order to save all settings that have been applied to set up our cross section 
sheets we need to save it out as a separate cross section sheet library. Go to the 
drop down option File > Sheet Library > Save As …  
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16) Navigate to your project folder C:\Projects\Roane\SR95PoplarCr, set the name 
to SR95Roadway10scale.xssl and click Save. In the future when you come 
back to this run, this cross section sheet library will automatically be opened for you. 

 

17) Exit the Cross Section Sheet Composition dialog and save your run. 

18) One additional tool for cross section sheets we will look at is the Place and 
Annotate Cross Section Sheets program. We have already placed sheets so 
we will not need those but here we show its use to place plot borders and additional 
project data annotation.  

From the Menu Bar in MicroStation, access the following pull down tool:  
T.D.O.T. → Cross Sections → Place and Annotate XS Sheets 

This tool is also available from D&C Manager at  
Drafting Standards → Cross Sections → XS Sheets 

Our sheets were placed as shared cells so we need plot borders for them and we 
want to add our project number so first click on those 2 options under Placement 
Control. Set the total number of sheets to 42 and make sure the scale is set to 10. 

Under Annotation, click off all options except Project No. as shown. In the 
Project No, keyin field enter 35256-2204-04. It is not necessary to clear the other 
keyin fields of their default values. 

Under Project Data Location set the option to Line #1. 
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19) Click on Place Graphics. Look at the upper right corner of your sheets. They 
should now include the project number. 

 

If you check, you should also find a plot borders overlaying the cross section sheet 
cells which were placed as shared cells.  
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We have shown this placement of the project number separately from where it could 
have been entered in GEOPAK’s Layout Cross Section Sheets tool on purpose 
since this number is often not available at the time of initial sheet generation.  

NOTES:  
Cross section sheets are placed as shared cells to reduce the file size. Due to the 
large number of elements and large numbers of sheets often required, this can 
increase the file size tremendously. Shared sheet cells show a plot border which is a 
part of the regular cell but since they do not contain the actual graphics, plotting 
software will not recognize them for automatic batch plotting which necessitates the 
placement of the plot border by itself. 

If at some point in the future project numbers or perhaps the year changes, you 
should use MicroStation’s Find/Replace Text tool to edit that text all at one time 
in a single DGN file or for multiple DGN files use T.D.O.T. Roaddway Design 
Division’s DGN Batch Text Editor. 

When preparing the cross section sheets for construction turn in, use the Place 
and Annotate Cross Section Sheets tool as shown in the previous 2 steps to 
put in the construction project data information with the Project Data Location set to 
Line #2. 

20) To prepare cross section sheets for plotting, levels should be set as needed in the 
cross section sheet DGN file ROSR95MainlineXSSheets.sht.  

Use Level Display to turn off levels DESIGN - SHEET - Plot Shape and 
DESIGN - SCRATCH - User 1 in View 1. Save this setting at File → Save 
Settings. 

Memory Problems when Batch Plotting Cross Section Sheets 

Batch plotting large numbers of cross section sheets at one time can cause memory 
problems due to the large number of DGN references used.  

If you encounter this problem, then either plot fewer sheets at one time or take the 
following steps to set up a separate file to plot from. 

1. Copy the cross section sheet DGN file.  

2. In the copy, open the Reference dialog, highlight all reference files and right 
click for or go to Tools → Merge Into Master.  
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3. When prompted to Select View For Merge, data point in View 1  

4. You may see the following Alert message. If so, click OK to complete the 
merge which will eliminate the DGN references. 

 

5. This file can now be used for plotting the entire set of cross section sheets at one 
time. If the original cross sections are changed in any way then 
this process will need to be repeated.  
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17. Cross Section Reports 
In this exercise we will take a look at cross section reports and actually run a 
seeding quantity report from our cross section graphics. 

1) Open the Microstation file 

C:\Projects\Roane\SR95PoplarCr\ROSR95MainlineXSections.dgn 

Access Project Manager. 

2) Select Reports and XS Quantities. 

From the XS Reports dialog, select the User → Preferences option. 
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NOTE:  
XS Reports can also be accessed from the 
MicroStation menu bar drop down location 
Applications → GEOPAK → Road → 
Cross Sections → Reports or from the 
cross section task group under Road 
Tools. 

3) In the Report Header dialog turn on the Date, click on the first Header option 
and enter S.R. 95 Roane Co. Set the tolerance to 0.01.  

 

Close the dialog when complete. 

4) From the XS Reports dialog, select the Seeding report 

5) In the Seeding dialog, set the Chain to SR95. The station fields are filled in when 
the chain is selected. 
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Click on the Candidate Seeding Elements button and fill in as shown. Use 
the Match button and data point on a side slope element in your proposed cross 
sections. The level name is DESIGN - TYPICAL - Finished Grade and 
Subgrade. 

 

Additional control settings are available at the bottom of the dialog. Change the 
subtotal option to Even at 500 and keyin the report name SR95seeding.txt at 
the bottom. 
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Click on the Apply button when complete. 

6) After processing is complete, dismiss the dialog. 

7) Using the GEOPAK Text Editor, review the report SR95seeding.txt.  

This report yields the square foot area of all grass slopes which can be used in 
calculation of any quantities related to slopes including seeding, sod, water, etc. 
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8) Exit the XS Reports dialog. 
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18. DP Station Offset & Labeler Tools 
In this exercise, we look at some tools for placing smart labels in our plans. These 
labels can automatically calculate values from chains, profiles, cross sections or 
even drainage structures. We will look specifically at the Plan View Labeler but all 
other labeler tools work in the same manner. 

First, we will take a quick look at what has to be one of the handiest tools GEOPAK 
has, the DP Station Offset tool, which sends a data point for you based on a station 
and offset. 

18a. DP Station Offset 
This tool can be used with any MicroStation or GEOPAK tool that needs a data 
point. In this exercise, we illustrate its use with MicroStation’s Zoom In command. 

Remember:  
If anything needs a data point, you can send one by station and offset with this tool. 

1) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\ROSR95Proposed.dgn 

Access Project Manager. 

2) Select the icon Plan View Design button from the Project Manager 
workflow dialog. 

3) From the Plan View Design tool bar, select the DP/Station Offset icon. 

 

This tool is also available from the Plans Prep & Quantities task group under 
the Horizontal Plans Preparation tools when running Civil Workflows. 
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4) We need to go to the beginning station of the transition from the 4 Lane Depressed 
Median section to the 5 Lane Curb & Gutter section at Sta. 316+75 so complete 
the dialog as shown below. 

 

5) Next, select the MicroStation Zoom In tool and press the DP button on the above 
dialog. Continue to click the DP button as the view is zoomed in onto this area of 
interest. 

You may need to turn off the Survey reference file to clear the view and rotate the 
view so that the transition area is horizontal. 
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18b. Plan View Labeler 
1) From the Plan View Design tool box, select the Plan View Labeler icon. 

 

or from the Plans Prep & Quantities task group in the Horizontal Plans 
Preparation tools. 

 

2) In the Plan View Labeler, first go to the drop down option Scale → Change 
Scale and key in 50. Click OK to set the scale. 

 

3) Select the Styles Tab. 

 

NOTE:  
By default, the standard plan view label style file for T.D.O.T. Rooadway Design 
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Division, tdotdef_plan.lsf is already loaded and available. Label styles are listed 
in the Item Selector list. 

4) Traverse within the Item Selector box to locate the following style: 

Labels → Design Labels → Roads → Beg Pvmt Trans 

 

5) Modify the option from Node and Shape Only to Complete Style to preview 
the defined style for this label. 

 

6) Press the Select Style Item button (checkmark) or double click on the style 
name to activate this style. 

Once activated, the label data is shown in the text display area on the right. You 
must not type text in here adjacent to any data item such as station and offset 
values with this style. Doing this will kill the intelligence of the label style. 
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7) Move back to the Text tab and complete the data items on the left as defined 
below: 

Job No.: 101 

Chain: SR95 

TIN File: RO095-01.tin 
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In the following steps, we will use the Plan View Labeler to label the beginning and 
ending station and offset for the transition area of the left and right roadways.  

8) To begin the process, under Label Feature at the lower left select the Data Point 
Location button and then data point the location that you wish for the Station and 
offset to be computed. Snap to the pavement line at the beginning of the pavement 
transition. The labeler automatically calculates the information.  

 

The Label Feature tool used depends on the label type. In our case, we are 
labeling a point location so we used Data Point Location. If we were labeling a 
distance on a line, we would use the Select GEOPAK or MS Element label feature 
tool. 

9) Use the Shape, Leader and Rotation tabs to experiment with different labeling 
options. Click the AA button under Rotation to use the current active angle which is 
normally set to 0. This will to force horizontal placement of the label. 
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For the best results make sure the Current Angle value is set to 0 prior to 
picking the desired rotation option. That angle value can influence the others. 

10) When you move your mouse pointer out over the view, the label is now attached to 
your cursor (without the leader for the delimiter). If you do not see the label, press 
the Place Label button on the right. Use this button anytime you must use other 
tools such as Zoom In just prior to placement to return focus to placing the label. 

 

11) Data point at the location you wish the text to be located. 
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12) Move your cursor around and notice the small circle jump from one end of the 
delimiter to the other.  

The next data point will define the side of the label to which the leader line will be 
drawn from the delimiter line to the computed location.  

 

Data point when positioned as desired. The leader line is added. 
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13) Using the same label style, repeat steps 8-12 to label the transition on the right 
side of the roadway. 

14) Activate style End Pvmt Trans to label the ends of the transitions. Try another 
rotation option such as 90 degrees to the alignment. 

 

15) Try using the Label Tool Box to start labels and to set rotation options. It can be 
accessed from the drop down location Options → Label Tools. 
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18c. Other Labelers 
Labelers are also available for labeling Profiles, Cross Sections and Drainage 
Structures. 

All of these labelers function about the same except for the computed inserts which 
are available. As you might guess, the computed inserts are based on objects found 
in that area of interest. 

If time permits, try out the Profile and Cross section Labelers which can be found at 
the locations given below. We do not have a drainage project set up on this job so 
you will not be able to use that one. 

1) Profile Labeler: 

Task Bar:  Civil Workflows → Plans Prep & Quantities → Profile 
Plans Preparation → Profile Labeling 

Menu Bar: Applications → GEOPAK →Road → Plans Preparation → 
Profile Labeling 

Style File: tdotdef_prof.lsf 

2) Cross Section Labeler: 

Task Bar:  Civil Workflows → Plans Prep & Quantities → Cross-
Section Plans Preparation → Cross Section Labeling 

Menu Bar: Applications → GEOPAK → Road → Cross Sections → 
Cross Section Labeling 

Style File: tdotdef_xs.lsf 

3) Drainage Labeler: (GEOPAK Drainage must be activated first) 

Tool Box:  Drainage Main → Utilities → Labeler 

Menu Bar: Drainage → Utilities → Labeler 

Style File: tdotdef_drainage.lsf 

 

T.D.O.T. Roadway Design Division Labeling Tools:  
Several labeling tools have been developed by T.D.O.T.’s Roadway Design Division for use 
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in plans preparation and can be accessed from Geopak’s D&C Manager under Drafting 
Standards or with the T.D.O.T. Roadway Design Division interface from the MicroStation 
drop down menu TDOT. Some of these are illustrated in chapter 21. 
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19. Plan and Profile Sheets 
In this exercise we will use GEOPAK’s Sheet Layout tools to set up our proposed 
layout sheets which we will set up as plan/profile sheets. 

19a. Set Up Sheet Layout DGN Files 
1) In order to assign the proper DGN reference files and levels from those references 

to the top (proposed plan) and bottom (profile) of our sheets, we need to set up 
“motif” DGN files.  

Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\Plan_Motif.dgn 

2) We will set up the top of our sheets with this motif file. Use MicroStation’s 
Reference tool to attach the following files as references and use Coincident 
World attachment mode. 

• ROSR95Alignments.dgn 

• ROSR95Proposed.dgn 

• RO095-01Survey.dgn 

3) Go to MicroStation’s Level Display tool and set levels in the references and the 
master dgn file for a proposed layout sheet.  

In the dialog set the control to View Display and highlight all files. 
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Set the Level control to Filters and then click on level filter Sheets – Proposed 
Layout. 

 

Finally, click the icon at the upper left of the Level Display dialog to Apply To 
Open Views. 

 

Use MicroStation’s File > Save Settings to save this set up of levels. 

4) Open the MicroStation file 

C:\Projects\Roane\SR95PoplarCr\ Profile_Motif.dgn 

5) We will set up the bottom of our sheets with this motif file so using MicroStation’s 
Reference tools attach the following files as references and use Coincident 
attachment mode. 

• ROSR95Alignments.dgn 

• ROSR95Proposed.dgn 

• RO095-01Survey.dgn 

6) Go to MicroStation’s Level Display tool and repeat step 3 using level filter 
Sheets – Profiles.  
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Switch back to Levels, click on the reference file ROSR95Alignments.dgn 
and turn the “DESIGN - SHEET…” levels off. We do not need the working profile 
grid and annotation from that reference file on our sheets. 

Use MicroStation’s File > Save Settings to save this set up of levels. 

19b. Configure Sheet Settings 
1) Create a blank DGN file to set up clipping shapes in. In MicroStation go to File → 

New and in the New dialog keyin filename ProposedLayout.dgn and use seed 
file Seed2D.dgn which should be set by default. 

Use MicroStation’s Reference tools to attach ROSR95Alignments.dgn and use 
Coincident World attachment mode. 

NOTE:  
The clipping shape DGN file can be referenced later to other files for help in 
orienting text, etc. to appear correctly on the sheets. 

2) Access Project Manager. Click the Plan & Profile Sheets button from the 
workflow dialog. 

3) Create a run SR95 to set up the plan/profile sheets. The Plan Sheet Layout 
menu bar will appear. 

If the plans sheet library tdot.psl is not already attached, go to drop down option 
 File → Sheet Library → Attach. 
 Navigate to C:\Users\Public\Geopak Standards\, pick tdot.psl and then 
click OK. 

 

4) Select drop down option Settings → Sheet Layout. Change Sheet View 
Attributes option to Customize with Motif Files then click OK. The 
completed dialog is shown below. 



19-4   Plan and Profile Sheets GEOPAK Road Course Guide 

 

NOTE:  
For sheet layouts where only one set of references is required, you could just use 
the Use Current Design File option and assign references and levels in the 
same DGN file where clipping borders are placed. However it is recommended 
that you use motif files for all sheet set ups to avoid attachment of the sheet clip 
boundary file as a reference to the plan sheets. 

5) Review sheet preferences by clicking File → Sheet Library → Edit. Change 
the sheet type to see settings for different types. 

 

You usually will never need to adjust these settings but can see we have the 
following sheet types set up for us already 

• DBLPLN split plan plan sheets (set up with continuous stationing from top 
through bottom for resurfacing project plan sheets) 

• PLAN  full plan sheets (All full plan sheets except Present Layout) 

• PLNPLN split plan plan sheets (set up with the same station limit on top & 
bottom for project phase layouts such as used for Traffic Control 
or Erosion Prevention Sediment Control sheets) 

• PLNPRO split plan profile sheets (Proposed Layout sheets w/Profiles) 

• PRESNT full present sheets (Present Layout sheets) 
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• PROFLE  full profile sheets (Profile sheets) 

6) Set the sheet type back to PLNPRO. Click on the category Port 1 (Plan). The 
Shape Symbology defines the symbology of the clipping shape that is placed in 
the layout operation. Review other settings as desired but do not make any 
changes. 

 

Close the Sheet Library dialog by clicking the X in the upper right of the dialog. Do 
Not save any changes. 

7) Populate the Plan Sheet Layout menu bar as shown below with sheet type 
PLNPRO and scale 50. 

 

8) Press the Sheet Composition icon (1st from left) on the Plan Sheet Layout 
menu bar. Populate the Sheet Composition dialog as shown below for 50 
scale sheets. 
 
 Set By Station Range: Radial and a Station Range of 1300 and other 
values are updated automatically 
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NOTE:  
The normal station range for 50 scale sheets is 1300’ which is determined by the 
limits of the grid on profile sheets. The Maximum Drawing Area indicates the area 
that could be used and is based on the scale being applied. By default, only station 
ranges in 50’ increments can be set. 

9) Dismiss the Sheet Composition dialog by pressing the X in the upper right 
hand corner. 

19c. Sheet Layout Process 
1) Press the Layout Sheets icon (2nd from left) on the Plan Sheet Layout menu bar. 

In the Layout Settings dialog your Job number should be set but if not click the 
browser button and select job number 101. 
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2) Double click on Plan (1st item in list), to set up the plan port. 

Populate the Plan Port Data dialog as shown below. Select the Motif File 
Plan_Motif.dgn and then click OK.  

 

3) Double click on Profile (2nd item in list) to set up the profile port.  

First, select the proposed profile SR95.  

Then, populate most of the Profile (Port 2) dialog by pressing the Identify 
Cell button then graphically identify the profile cell. It may be necessary to turn on 
level DESIGN - SHEET - Light Grid in the alignments file to see the profile cell.  

Select the Motif File Profile_Motif.dgn and then click OK. 
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NOTE:  
The X and Y coordinates may be different than what is shown in the dialog. They 
should match the insertion point of your GEOPAK profile cell. 

4) In the Layout Settings dialog, set the Extend value for the Begin Station to 
-650. This will force the first sheet to begin 650’ before the chain. The dialog should 
appear as below. Click the Layout 6 Sheets button to draw the clipping borders 
into the DGN file. 
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6 clipping shapes should be placed along the proposed centerline for the plan port. 

 

6 clipping shapes should be placed along the proposed profile for the profile port. 

 

NOTE:  
Clipping borders are placed on level “DESIGN - SCRATCH - User 1” so it may 
be necessary to turn that level on to see these shapes. 

5) Dismiss the Layout Settings dialog by pressing the X in the upper right hand 
corner. 

19d. Modify Sheet Numbers 
The following steps demonstrate methods for controlling the sheet numbers applied.  
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1) Click the Sheet Number Manager icon (5th from left) on the Plan Sheet Layout 
menu bar. This will open the following dialog. 

 

2) Click & hold mouse button down while dragging the cursor to highlight all sheets. 
Then click on the Edit Sheet Number icon on the right. 
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3) In the Edit Sheet Number dialog set the Compute Sheet Number By option to 
Starting at Sheet Number and set the value to 4.  

Click on the option to Append Alpha Suffix. Our sheets need the suffix “A” so 
under Beginning Letter(s): enter the A. 

 

4) Click OK to apply the numbering changes. The Sheet Number Manager dialog 
should reflect the changes you have requested. 

 

5) Dismiss the Sheet Numbers Manager dialog by pressing the X in the upper 
right hand corner. When prompted to Save Changes click the Yes button. 
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19e. Clip Sheets 
1) Press the Clip Sheets icon (3rd from left) on the Plan Sheet Layout menu bar. 

Populate the Clip Sheets dialog as specified.  

• Set the project Directory where sheet DGNs should be created. 
• The Sheet Name Prefix field is used to control the final format for the DGN 

filenames which are applied. The number of characters used for the sheet 
number as well as the filename extension can be set.  
Enter square brackets with 4 asterisks for the sheet number, [****] , followed 
by .sht for the filename extension. You should end up with [****].sht. Notice 
that the filename format is reflected to the right for the first sheet. See the note on 
the following page for an explanation of this format. 

• Set Orientation to the Rotate View option. 
• Keyin a Sheet Title if desired at the time of sheet generation. For this class 

we will specify R.O.W. This is the label for “TYPE” in the project data block on 
the upper right corner of our sheets.  

• Keyin a Project Number if known at the time of sheet generation. For this 
class we will specify 35256-2204-04. 

• Keyin Match Line prefix text: MATCH LINE STA. & suffix text: SEE SHT. 
NO. 
Make sure to include a blank space in the Match Line text prefix field after the 
period in “STA.”. This will provide a blank space between “STA.” and the 
computed match line station text. For the same reason you should include a 
space before "SEE" in the suffix text. 
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NOTE:  
The number of asterisks entered within the square brackets in the Sheet Name 
Prefix field should be determined by the maximum number of characters expected 
in any project sheet number plus whatever is required for suffixes in the 
sheets that are being created. For a project ending in sheet number 126, that 
would be 3 +1 for 1 suffix letter or 3+2 if double suffix letters are required. If sheets 
are being created without suffixes simply base it on the highest sheet number such 
as sheets 31 – 36 in the 126 sheet set would need only 3 asterisks.  

The software automatically embeds zeros as needed to fill out the sheet number for 
sheets with fewer characters which will set up the sheets in alphabetic order.  
 
There are several reasons why the sheet files need to be named in this manner 
using the sheet number: the project will be easier to plot using InterPlot Organizer or 
other batch plotting functions since sheets will automatically be read in order 
alphabetically, the names of the sheet files should be the same as the sheet number 
so the project can be published to FileNet correctly and so other divisions, such as 
Right-of-Way and Construction, can find the sheets they need easily. 

2) Click Process Sheets button to create the plan and profile sheets. 

3) Open any of the newly created files to see the resulting sheets. You will need to 
change your Files of type to Sheet Files [*.s*]. 
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4) Close the Plan Sheet Layout menu bar and save settings for the run when 
prompted. 
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20. D&C Manager – Additional Functions 
In this exercise we will demonstrate other ways to use D&C Manager, to control 
graphics displayed, cell access and quantity calculation from graphics. 

20a. Display Control 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Proposed.dgn 

2) Go to File → References and turn on the display of the Survey topo and 
Alignments DGN files. Fit the view so that all graphics are showing. 

3) Access the D&C Manager. 

Select the item Drafting Standards → Roadway Linework → EOP Prop  

4) Set Display mode in Design and Computation Manager. In the expanded dialog, 
click on the Display icon (computer screen view divisions) which will open up the 
Display control tool box. 

 

 

NOTE:  
In D&C Manager’s tool box mode the Display control icons are shown always and 
you can pick them as needed. 
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5) The different display control icons change display for a D&C Manager item or items 
as follows: 

 

Normal Display   all graphics are shown 

Highlight Selection  items are highlighted 

Hide Selection   items are turned off 

Display only Selection  only items are shown 

Try the different modes out while you have EOP Prop selected. You may need to 
zoom in on the plan view graphics. 

NOTE:  
One of the best uses for the Display functions are to check graphics such as 
pavement lines or guardrail items when they are not being reflected in cross section 
runs. The Display controls can show you immediately if graphics are not set at the 
correct level or symbology. 

6) Back in D&C Manager, select the category Drafting Standards → Guardrail. 
Select the last display icon, Display only Selection. 
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Now only the guardrail items placed previously are showing. 

7) Select the item Drafting Standards → Guardrail →GR Single Prop. 

 

Now only that guardrail item should be showing. 

In case you haven’t discovered this by accident, if you double click on an item in 
D&C Manager’s expanded mode then it is added to a collection box at the bottom. 
This way you can pick several different items for the Display functions to work on. If 
you right click in the collection area then you will get options to Clear the collection, 
Save it or Open one saved previously. 

8) Try adding different items under guardrail to the collection box and experiment with 
the Display controls to check the results. 
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9) Right click in the collection area at the bottom of D&C Manager and pick Clear 
Collection. Select the Normal Display mode so that all graphics are showing 
again. 

20b. Cell Access 
The T.D.O.T. Roadway Design Division cell libraries provide over 1200 standard 
cells. Although GEOPAK does provide tools for placing individual cells defined as 
items in D&C Manager, it is just not feasible to set up so many that way. Instead we 
have MicroStation visual basic applications called from D&C Manager which access 
groups of cells. 

In this exercise we will look at the cell access dialog for Traffic Control Device Cells 
to illustrate how these cell dialogs function. 

1) Access D&C Manager and set mode to Design. 

2) Double click on item  
Drafting Standards → Traffic Control (Temporary) → TC Device Cells 

The Traffic Control Device Cells dialog is opened. 

 

All cell dialogs are in this same basic format, a cell pick list by description on the left 
with a viewing window on the right.  

At the bottom left of the dialog is the Cell Placement Type option.  

A “window shade” minimize button is located on the upper right.  

The Restart Cell Place command button at the upper left can be used anytime 
other MicroStation commands have been used and you wish to go back to placing 
the currently selected cell. 
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Also included at the bottom are other special programs that might be needed or 
used in conjunction with these cells. In most cases the special tool options on cell 
dialogs are also accessible from D&C Manager directly. 

3) When a cell is chosen from the list, the cell is made active and placement is started. 
The method of cell placement depends on the Cell Placement Type which is set 
at the lower left. The default value for this option varies and is set to the most 
common one needed for the cells from the dialog. 

Click on the Cell Placement Type button and review the options which are 
described here: 

 
Simple Place places cell with MicroStation’s Place Cell command with 

settings for angle and scale 
Place/Rotate places cell by data point with dynamic rotation and 

setting for scale 
Place Along places cells along an element with settings for spacing, 

scale and angle 
Place Sign With … available on the sign cell dialogs, includes placement of 

sign face with text label, leader line and sign symbol 
The Traffic Control dialog defaults to Place/Rotate but instead of using that method 
click on the option button and set it to Simple Place.  

4) Scroll down the cell list and pick any cell. MicroStation’s Place Cell command is 
started. Adjustments can be made for angle and scale prior to placing cell as needed 
using these basic controls. 
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Data Point to place the cell. You may need to turn on level, DESIGN - TRAFFIC 
CONTROL TEMPORARY – Devices, to see the cell. 

5) Click on the Cell Placement Type button and set it to Place/Rotate. 

Pick another cell from the list. The Place Cell & Rotate dialog opens where you 
can adjust the scale as needed. 

Data point in graphics at a location for the cell. Rotation is started so that the 
angle can be set dynamically. 
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Data point to set the angle and place the cell.  

The Place Cell command button on the Place Cell & Rotate dialog can be used 
anytime other MicroStation commands have been used and you wish to go back to 
placing the active cell with dynamic rotation 

6) Click on the Cell Placement Type button and set it to Place Along. 

Scroll back up in the cell list and pick the cell Barrel – Left. The Place Cells 
Along Element dialog opens where you can make control settings as needed. 

Set the control settings as shown below: Spacing 55, Scale 50 & Angle 0. 

 

Click the Place Cells Along command button.  

In the prompt field of the MicroStation status bar, we are being prompted to 
Identify Element at beginning location. Data point anywhere along our 
inside edge of pavement on the right side of the roadway. 

Once the line is identified, we are prompted to Accept/Reject …Identify 
direction\end. Accept the pavement line element to the right. 

Barrel cells are placed on the 55’ spacing along this line between the points given. 
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NOTE:  
For the user’s convenience all cell dialogs are available through the following 
locations: 

D&C Manager items as illustrated in this exercise 

T.D.O.T. drop down menu from the MicroStation menu bar with TDOT 
interface active 

TDOT Design Division Tool Box special tool box with many commonly used 
functions including GEOPAK & 
MicroStation tools as well as customized 
T.D.O.T. Roadway Design Division tools.  
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The TDOT Design Division Tool Box is available from MicroStation menu bar at  
T.D.O.T. → Tools → Design Division Tool Box 
 
or from GEOPAK’s D&C Manager at  
Drafting Standards → Tools → Design Toolbox 
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20c. Quantities 
1) Access the D&C Manager. 

2) Select the category Pay Items → Guardrail Items 

3) Set Compute mode in Design and Computation Manager. In the expanded dialog 
click on the Compute icon (small calculator) which will open up the Plan 
Quantity Computation dialog. 

 

 

4) Make sure the Job is set to 101 and Extents is set to View.  

Set the Baseline Reference to None and click on the Highlight During 
Computation option 

 

5) Adjust your View 1 as needed so that our guardrail is shown there. Turn on level 
DESIGN - TRANSPORTATION - Roadside Barriers and refit the view so 
that you see the guardrail on the left around station 290+00.  
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6) Click on Compute Quantities. The graphics are read and the Computation 
Results dialog is opened with the totals for items under the selected category. 

 

In the MicroStation view, the guardrail items are marked with your highlight color. 

 

NOTE:  
The quantities displayed in the Computation Results dialog can be saved to a 
CSV file (comma separated values) which can then be used to import quantities 
directly into the Estimated Roadway Quantities Excel worksheet. In the 
Computation Results dialog set Export Format to CSV By Item, keyin a 
filename and click Export.  

7) Since we need station limits for our guardrail tabulations let’s try a different set up. In 
the Plan Quantity Computation dialog set Baseline Reference to Chain and 
chain SR95 as shown. The Range setting is used to make sure items on other 
roadways are ignored and Stations can limit the area of the specified roadway as 
well. 
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8) Click on Compute quantities. In the Computation Results dialog set Export 
Format to Comp Book, keyin the filename SR95guardrail.txt and click 
Export. 

 

9) Use GEOPAK’s text editor to open the file SR95guardrail.txt and review the 
results of your latest computation. 
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NOTE:  
Guardrail quantities generated in this way can be used to automatically build the 
data into our standard tabulation format using the program available in standard 
Microsoft Excel template Guardrail Tab Builder.xltm.  

10) Experiment with different modes and export options to familiarize yourself with the 
computation functions.  

If you wish, calculate some quantities on the traffic control devices placed in 
the previous exercise or perhaps the 6-30 C&G we placed in the urban section at 
the end of the project. 

For the curb and gutter, you can use a rate of 0.07181 cubic yards of concrete per 
foot which would be used for a gutter thickness of 9”. The user is prompted for this 
rate on each C&G element that is found. It will remember the last rate entered so 
you only have to key it in once and can just accept it on subsequent elements.  

Refer to standard roadway drawings RP-MC-1, RP-MC-2 and RP-NMC-10 for 
applicable rates of concrete per linear foot for curb and gutter. 

As was illustrated with the Display functions at the beginning of this chapter, a 
Collection area is set up at the bottom of D&C Manager when in Compute mode 
to allow the selection of various items from different categories under Pay Items.  

NOTE:  
Only D&C Manager items under the Pay Items category are set up for quantity 
calculation from graphics. 

11) Exit the Plan Quantity Computation dialog and Design and Computation 
Manager. 
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21. Graphical COGO – Proposed R.O.W. 
In this exercise we will demonstrate the use of another set of COGO tools, Graphical 
COGO. It is set up to store points graphically and can be used with visualized 
COGO elements to perform MicroStation like manipulations which translate into 
actual coordinate geometry stored in the GPK database. 

For our exercise, we will store some proposed R.O.W. and annotate it using D&C 
Manager. 

NOTE:  
For complete documentation on setting up proposed R.O.W. and easements, refer 
to standard documentation file ProposedROW.pdf which can be found under 
Documentation at the T.D.O.T. Roadway Design Division web page address: 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm 

21a. Initial Set Up 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Proposed.dgn 

Access Project Manager. 

2) From the Classic Geometry task group, select the Graphical COGO icon 
(2nd from left). 

 

The COGO dialog opens and the Graphical COGO toolbox 
appears. 

 

Note that in the Classic Geometry task display the second 
group of tools are the same so you can go directly to a 
given Graphical COGO tool if desired. 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm
http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm
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3) Before we store proposed R.O.W. points we need to set the feature PROW in 
COGO. Turn on Permanent Visualization and click the Browse button to 
set the feature. 

Feature PROW is found under Design → Property/ROW.  

 

4) Back in the main COGO dialog we can see our feature has been set. Minimize the 
COGO dialog to clear your screen area. 
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21b. Store Proposed R.O.W. Points/Breaks 
5) Zoom into the area near 325+00. At this location our slopes go beyond the existing 

R.O.W. on the left so we will need some proposed R.O.W. 

Use MicroStation’s Level Display and the level filter Sheets - ROW Details to 
set the levels in the master file and all reference files. Switch back to Levels and 
turn on level DESIGN - ROW - ROW and Easement GPK Visualizations in 
the proposed file.  

Use MicroStation’s Copy Parallel command to locate the extreme points of the 
needed R.O.W. (Offset 15’).  Turn off the graphic group lock so that you do not 
copy all of them parallel. 

 

6) Now use MicroStation’s Smart Line tool with sharp breaks to set a preliminary 
proposed R.O.W. line.  
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The finished preliminary line should appear similar to the one shown below. 

 

7) Now we are ready to start storing our R.O.W. points.  

In the graphical COGO tool box or from the Classic Geometry tool options click on 
the Store Point icon at upper left.  

Set the point Id to DR1 (begin point name), Coordinates control to Curvilinear 
and set chain SR95. You should now be tracking along the centerline. 

 

8) Using Intersection snap, locate the first point at the intersection with the existing 
R.O.W. on the left. Data point to store the point DR1.  

9) Go to the next break in the preliminary R.O.W. line and Keypoint snap to it but do 
not data point yet. Instead go to the tool settings box click on the Station value 
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and round to the nearest even station which should be 324+00. Click the lock box 
to hold the new station value 

 

Now go down to the Offset and round to the nearest even foot which should be 
about -140. Don’t forget the negative sign since we are on the left side of the road. 

 

The station & offset should be locked in. Data point in the view to store the point 
DR2. 
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10) Repeat step 9 to store point DR3 at Station 327+00, Offset -130. You must click 
on the lock toggle boxes to un-lock the station and offset values and return to 
dynamic location mode. 

 

11) Using Intersection snap, locate the last point at the intersection with the existing 
R.O.W. on the right. Data point to store the point DR4. 

12) Open the main COGO dialog and we can see that our proposed R.O.W. points 
have been stored. 
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21c. Store Proposed R.O.W. Chain & Annotate 
1) Now that our points are stored, we can build a chain from them. Click on the 

Chain from Elements icon in the main COGO dialog. 

 

Key in chain name DROW1 and Double click on our visualized points in 
MicroStation to build the chain element list. Stationing really doesn’t matter on 
R.O.W. chains just set it to begin at 0. 

 

Click the Store Chain button. 

2) Turn off the level DESIGN - ROW - ROW and Easement GPK 
Visualizations and delete the remaining temporary construction graphics we 
created to set our R.O.W. 
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3) Open up D&C Manager and select item Drafting Standards → Prop. 
R.O.W.→ R.O.W. Prop. In the secondary dialog, click on the Draw Plan & 
Profile button. Set the dialog to chains and single click on our proposed R.O.W. 
chain DROW1. Linework and distance/bearing annotation is placed. 

 

4) Add the proposed R.O.W. lines to a MicroStation selection set. 

5) Double click on D&C Manager item Drafting Standards → Prop. R.O.W.→ 
ROW Flags.  

When prompted enter Job number 101, roadway chain SR95 and click OK to 
place R.O.W. markers. 

 

After applying R.O.W. flags in batch mode always review annotation for any clean up 
that might be needed so that all text is readable.  

6) Close COGO and save an input file if you wish. 
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21d. Alternate Labeling Tools 
On the previous page we illustrated ways to apply annotation to proposed R.O.W. in 
a batch mode annotating multiple locations at one time. In some cases you may 
wish to annotate single segments or breaks of proposed R.O.W. when small 
changes are made. The T.D.O.T. Roadway Design Division provides the following 
tools to deal with those situations. Take the time to try each of these out on the 
proposed R.O.W. we have developed in this exercise.  

1) Since these tools use the current active symbology and text settings, it is necessary 
to use T.D.O.T. Roadway Design Division’s Text Styles Plus… tool to set those.  

It can be accessed from Geopak’s D&C Manager at Drafting Standards → 
Tools → Labeling → Textstyles Plus or with the T.D.O.T. Roadway Design 
Division interface from the MicroStation drop down menu TDOT → Text Styles 
Plus… or from the Roadway Design Division Tool Strip. The labeling tool dialogs 
provide an access point as well. 

 

 
Make the following choices based on the type of annotation being placed: 

ROW & Easements – Prop. For generic labels such as “PROP. R.O.W.” 

ROW Bearing & Distance – Prop. For prop. R.O.W. & easement segments, 
also used when labeling arcs which are part 
of prop. R.O.W. or easements 
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ROW Sta. & Offset – Prop. For prop. R.O.W. & easement breaks or 
intersections with R.O.W. or property lines 

2) The Label Station/Offset tool can be used to label proposed R.O.W. breaks or 
intersections with property lines. 

It can be accessed from Geopak’s D&C Manager at Drafting Standards → 
Prop. R.O.W. → StationOffset or with the T.D.O.T. Roadway Design Division 
interface from the MicroStation drop down menu TDOT → R.O.W. → Label 
Station & Offset 

 

3) The Place Bearing & Distance Label and Place Arc Radius & Length 
tools can be used to label proposed R.O.W. segments. On short prop. R.O.W. lines 
or arcs these tools may be used to place the annotation with leader lines as a flag. 

They can be accessed from Geopak’s D&C Manager at Drafting Standards → 
Prop. R.O.W. → BearingDistance & RadiusLegth or with the T.D.O.T. 
Roadway Design Division interface from the MicroStation drop down menu TDOT 
→ R.O.W. → Label Bearing & Distance & Label Arc Radius & Length 
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Proposed R.O.W. on Metric Projects 
When annotating proposed R.O.W. on metric projects we are required to annotate 
dimensions in both metric and English units. The tools shown above automatically include 
both measurements when used in metric DGN files. 

4) The Place Label with Leader Line tool can be used to place generic text 
labels for proposed R.O.W. 

It can be accessed from Geopak’s D&C Manager at Drafting Standards → 
Tools → Labeling → LabelwithLeader or with the T.D.O.T. Roadway Design 
Division interface from the MicroStation drop down menu TDOT → Tools → 
Place Label with Leader 

 

Example of label placement: 
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NOTE:  
For complete documentation on special programs developed by T.D.O.T.’s Roadway 
Design Division for use in MicroStation with Geopak, refer to standard documentation file 
TDOTRoadwayDesignDivisionPrograms.pdf which can be found under 
Documentation at the T.D.O.T. Roadway Design Division web page address: 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm 

GEOPAK Plan View Labeler:  
As shown in chapter 18, the Geopak Plan View Labeler can be utilized as well to place 
annotation for proposed R.O.W. and other features in the project. 

 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm
http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm
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22. Proposed & Final TIN Creation 
This exercise shows the basic steps for building cross section data and forming a 
proposed and a final TIN for our project roadway. The final tin is the surface as it 
would be after construction of the roadway; in other words, a combination of the 
current existing surface and the proposed roadway development. 

The proposed tin can be used to help develop side road tie ins. In chapter 23, we will 
use the proposed tin which we develop in this chapter with the Draw Profile tool to 
illustrate cutting a profile across multiple surfaces at one time. 

Data from the final TIN file is used for both culvert and storm drainage design. In 
conjunction with the GEOPAK DTM Tools, drainage areas and water flow can be 
carefully mapped out. With culverts, it is used to set preliminary invert elevations and 
to cut tail water sections. For storm sewer design, it automatically gets elevations at 
the gutter line and sets up the spread section at inlets. There are other methods of 
generating this information but the use of a final TIN is the preferred method.  

T.D.O.T uses GEOPAK to create final TIN digital terrain models from proposed 
cross section graphics. It is important to include cross section data generated at all 
critical locations. These may include any of the following: 

• Superelevation rate transition limits 

• Beginning and ending of width transitions  

• Locations where typical section changes 

• Side road data  

• Intersections with large radii should be cross sectioned around the radius  

• Ramp data on roadways with interchanges 

• Handicap Ramps (cross section immediately before & after with 2 within central 
pathway) 

If side roads, ramps or large intersection radii are involved, it will be necessary to 
repeat some steps to gather data from these additional areas. Due to the time 
available for this class, we will not include side roads in our final tin. 
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22a. 1BGenerating Cross Section Data 
1) Create two new DGN files, FinalTINPatterns.dgn & 

FinalTINXSections.dgn, for generation of cross section data, one for patterns 
from DGN seed file Seed2D.dgn and one for cross sections from seed file 
SeedXS.dgn. 

2) Open the MicroStation file FinalTINPatterns.dgn. Access the Project 
Manager workflow dialog. Click on Draw Pattern and create a new run 
finaltin  

Double click on the symbology review window to make the following settings. 
Level name is DESIGN – CENTERLINE – Proposed. 

 

Our roadway includes superelevation, so reference the super shapes DGN file 
ROSR95SEShapes.dgn. In the Draw Pattern dialog, set the placement option to 
Superelevation Transitions and hit Draw Pattern Lines. This generates 
pattern lines at all critical superelevation locations. 

 

3) Our roadway includes width transitions and a location where the typical section 
changes so click on Superelevation Transitions and change to Once.  
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Our pavement transition stations are 316+75 & 327+75 and the typical section 
changes at 328+25. In the next step, we will place regular pattern lines at a 5’ 
interval so these will be covered then.  

We do have a shoulder transition where the Type 38 terminal pad is located near 
station 292+50 on the left. We don’t know the exact stations but using the dynamic 
station icon to the right of the station entry field, we can snap to each of the five 
control points of the pad to set their stations. 

Attach file ROSR95Proposed.dgn as a reference and turn on level DESIGN - 
TRANSPORTATION - GR Special Slope Limit Lines. Go to the guardrail 
terminal area near 292+50. The stations should be found to be 291+82.22, 
292+12.50, 292+37.50, 292+62.50 & 293+66.56. Refer to standard 
roadway drawing S-GR-38 for Type 38 terminal pad layouts. 

 

Enter each of these stations and each time hit Draw Pattern Lines to place a 
pattern line there.  
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4) Change the placement option to Even and set the interval for pattern placement to 
5. Reset station values to the begin and end as shown below in the Draw 
Pattern Lines dialog and hit Draw Pattern Lines.  

 

NOTE:  
An interval increment of 5’ or some other small value is recommended in order to 
ensure that an accurate proposed tin is formed from the cross section data. 

5) Close the Draw Pattern Lines dialog and save settings on the run. 

6) Make a copy of the working alignment run SR95 and call it 95FINAL. We will set 
it up for producing the final TIN. Open the copied run. 

Click on the Define button for working alignments. Access the Pattern dialog 
and set the filename to FinalTINPatterns.dgn and reset search criteria to 
match the ones used for your pattern lines.  

 

Click OK to save the settings. 
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7) Open the MicroStation file FinalTINXSections.dgn. Access the Project 
Manager workflow dialog again and click on Existing Ground Cross 
Sections. Create a new run named finaltin. Most settings are automatically 
made from entries in the working alignment definition.  

Make sure Type under Surfaces is set to Line String and set symbologies for 
existing ground and void areas by double clicking on symbology view windows. Both 
use level SURVEY - GROUND - Top of Ground.  

After setting surface values, click the Modify Surface Settings option to the 
right of the surface list. 

     

  Exist. Ground    Void 

                                 

When all settings are made, click on Draw. 

8) Close the Draw Cross Sections dialog and save settings on the run. 
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9) Finish setting up the working alignment. Access the Cross Section View 
dialog and set the filename to FinalTINXSections.dgn.  

 

Click OK to save the settings. 

10) Access the Project Manager workflow dialog again, click on Proposed Cross 
Sections and copy the run Final which you set up previously to generate regular 
roadway cross sections and call it PropTIN. Open the copied run. 
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11) In the Define Variables dialog of Proposed Cross Sections reset the XS DGN 
filename to FinalTINXSections.dgn and set Place XS Grid? & Plot Slope 
Lines in Plan? to N. 

 

12) No other changes need to be done to the run so we are ready to generate the 
proposed cross sections. 

Go to the drop down option File → Run on the Proposed Cross Sections dialog. 
In the Proposed Cross Sections run dialog, make sure Pause On Each Section is 
clicked off.  

Depending on the length of a project the proposed cross sections may take some 
time to run due to the large number of cross sections being generated. Click on 
the Disable View Update option so that it doesn’t have to update the graphic 
display constantly. 

 

Click Apply. 
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13) Once cross sections are completed, exit the Proposed Cross Sections dialog and 
be sure and click Yes when prompted to save the settings just made. 

22b. 2BBuild Proposed & Final TIN 
14) Open the XS Reports dialog.  

It can be accessed from Project Manager button Reports and XS Quantities, 
from the MicroStation menu bar drop down location Applications →GEOPAK → 
Road → Cross Sections → Reports or from the cross section task group 
under Road Tools. 

 

15) On the XS Report dialog, click on the Highlight option at the bottom and select 
the option DTM Input.  

 

NOTE:  
The option DTM Proposed 3D can be used generate the same data but it 
includes an option for ground line data which we should not use since it will only 
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pull existing ground data from the cross section. We will add all ground data we 
need in the final TIN from the existing TIN file. 

16) This opens the Creating DTM Input File dialog. Make settings as shown below.  
Set the ASCII filename to SR95proposed.dat, click on the XS Elements 
button to set the Candidate Elements symbology.  

 

Color 2 (subgrade) and color 161 (curb, gutter, sidewalk & wall bottoms) should not 
be included. The only data desired from proposed cross section graphics is along 
the finished grade. The level name is DESIGN - TYPICAL - Finished Grade 
and Subgrade.  

Make the settings as shown and use the Display button to check them on your 
cross section graphics.  

 

Click the red X to dismiss the Candidate Elements dialog and click Apply on the 
main dialog to start processing. 

NOTE:  
If your project needs to include data from other cross sections such as side roads or 
ramps, steps up to this point should be repeated for the other areas. Once done, 
use Copy & Paste in any text editor to combine the data in one single DAT file. 

Where roadways meet, intersection EOP lines should be used to limit proposed 
cross data to the edge of the travel lanes so that it will not be necessary to edit the 
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resulting proposed surface to delete invalid points such as curb or slope points 
crossing intersections. 

When creating bridge deck surfaces, the level DESIGN - SURFACE - Bridge 
Surface Construction Lines should be included. Lines placed on this level take 
care of bridge overhangs and gaps which cause problems during surface creation. 

17) Now we are ready to create a proposed TIN file from the data which we have put 
together. Access the DTM Tools from the MicroStation menu bar drop down 
location  
Applications → GEOPAK → Road → DTM Tools or the Existing Ground 
button on the Project Manager dialog. Create a new run called final.  

You may wish to use either the tool box 

 

or the Menu bar 

 

18) Open the Build Triangles dialog and enter filenames as shown below. Set the 
Dissolve Option to Side and set the side length to 50. This control will prevent 
long skinny triangles from forming along outside of proposed slopes. Once entered 
hit Process. 

 

 

NOTE:  
The value entered for the Dissolve Option depends on your job. If cuts and fills are 
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light a value between 50 & 100 should work. If cuts or fills are large, a larger value 
should be used to avoid holes in your TIN. 
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19) Review the proposed TIN file just created. Open the FinalTINPatterns.dgn file 
or some other scratch DGN file. Use the Load DTM Features tool to load 
triangles, contours, etc.  

Before displaying graphics, go to File → Open in the Load DTM Features dialog 
and attach tdotPROP.lpf, found under C:\Users\Public\Geopak Standards, 
which is set up for proposed TIN surface displays 

Make sure the proposed TIN includes no holes or long triangles on the sides. You 
also may wish to create a temporary cross section file and cut some sections to 
check your proposed roadway TIN. 

 

 

If needed, use the Edit Triangles function under DTM Tools to dynamically 
delete any invalid points/triangle vertices. 

20) Once satisfied with your proposed TIN you are ready for the final step. We need to 
merge the proposed TIN with the existing TIN to form a complete final TIN. In DTM 
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Tools under Build open the Merge TIN Files dialog. Fill in filenames as shown 
below and hit Process. 

 

 

This eliminates all existing points within the area of the proposed TIN file and then 
combines the proposed data with the remaining existing data in the new TIN file.  

NOTE on Long Projects: 
Some final TINs created for larger projects may prove cumbersome to use or create. 
If problems are encountered on larger jobs, it is suggested that some controlling 
drainage feature such as a ridgeline across the project be located and then used as 
a dividing line so that two separate final TINs be can be formed that will function on 
their own.  

21) At this point review the final TIN by generating final contours in a 3D DGN file. 

Create a new MicroStation DGN file named FinalTIN.dgn using seed file 
Seed3D.dgn.  

Open the Load DTM Features tool. Turn off all feature items but Major and 
Minor Contour lines. Under the main Contour feature make interval settings as 
shown, Minor:0.5, Major:5. 

 

Once set, click on Load. 
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Delete the Global Origin note text and circle and then Fit View in MicroStation. 

 

Use MicroStation’s Dynamic View rotation and Zoom commands to check out your 
surface. This view is looking down through our transition area. 

 

 



Exercise 23 

GEOPAK V8i (SELECT Series 2)  Side Roads   23-1 

23. Side Roads 
In this exercise we will use Graphical COGO & the Draw Profile tool to begin the 
design of a side road. All of the functions we have worked with to design our 
mainline roadway S.R. 95 can be used to develop side roads as well. The tools in 
this chapter are presented as an alternative to some of the functions we used 
previously for S.R. 95. 

Private Drives: 
Any private drives, businesses and field entrances with possible slope 
encroachments, in extreme cuts or fills or any that need more complex vertical 
alignments will need to be designed using regular roadway design functions 
presented in this manual. 

We do have a batch process developed for automatic production of private drive 
profiles which can be used on drives that do not involve any of the design situations 
listed above that would require more in depth study. For complete documentation on 
batch processing of private drive profiles, refer to standard documentation file 
PvtDrProfiles.pdf which can be found under Documentation at the T.D.O.T. 
Roadway Design Division web page address: 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm 

23a. Initial Set Up 
1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Alignments.dgn 

Access Project Manager. 

2) From the Classic Geometry task group, select the Graphical COGO icon. 

 

The COGO dialog opens and the Graphical COGO toolbox 
appears. 

 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm
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3)  Before we store proposed centerline points, we need to set the feature D_POINT in 
COGO. Turn on Permanent Visualization and click the Browse button to 
set the feature. 

Feature D_POINT is found under Design.  

4) Back in the main COGO dialog we can see our feature has been set. Minimize the 
COGO dialog to clear your screen area. 
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23b. Graphical COGO Centerline 
In this section we are going to use Graphical COGO to store 2 points to define a 
centerline chain for Westover Dr. We will use this chain later to illustrate the use of 
the Draw Profile tool.  

NOTE:  
In the normal workflow existing centerlines for side roads are set up and provided by 
Survey. If realignment for the side road is indicated in the APR for the project, 
Survey will develop a preliminary proposed centerline as well. Design personnel 
would then determine whether those centerlines can be used in the final design. 

1) Zoom in on Westover Drive near the end of our SR95 chain. 

Using MicroStation, draw 2 perpendicular lines across Westover Drive between 
the existing edge of pavement lines. It may be necessary to turn on the Survey 
reference file RO095-01Survey.dgn and level SURVEY - 
TRANSPORTATION – Roads. 

 

Using Midpoint snap, draw a line from the middle of the first line to the middle of the 
second. 
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Use MicroStation’s Trim to Element tool to extend the line to the SR95 centerline 
chain. 

 

2) Access the Graphical COGO Store Point command. Set the point name to 
D201 and switch the Coordinates option to Cartesian. 
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3) Keypoint snap and data point at the ends of our constructed centerline to store 
points D201 and D202. 

 

4) Now that our points are stored, we can build a chain from them. Click on the 
Chain from Elements icon in the main COGO dialog. 

Key in chain name WESTOVER and for now set the begin station as 10+00. 
Double click on our visualized points in MicroStation to build the chain element 
list. 

 

Click the Store Chain button. 
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5) Go to COGO Navigator and describe the chain WESTOVER. 

 

We can see that our chain ends at SR95 with an odd station. This station value will 
vary depending on where point D201 was stored. 

6) Click on the Station Chain icon on the main COGO dialog. 

 

7) In the Station Chain dialog set chain WESTOVER, station 30+00 Back and 
object point D202. This will back our stationing in from the end giving an even 
station at the SR95 intersection. When re-stationing a chain, the object stationed 
from must be a part of the chain. 
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Turn on Redefine in the main COGO dialog and click the Station Chain 
button. 

8) Go to the Navigator and describe the chain again. It should now end at 30+00. 

 

9) Close COGO and save an input file if you wish. 

23c.  Draw Profile  
The proposed tin created for the mainline roadway can be used to help develop side 
road tie-ins. In this section, we will use the proposed tin which we developed for S.R. 
95 with the Draw Profile tool to illustrate cutting a profile across multiple surfaces at 
one time. 

1) Open the Draw Profile dialog. It can be accessed from the MicroStation menu 
bar drop down location.  

Applications → GEOPAK → Road → Plans Preparations → Draw 
Profiles  

or from the Road Tools task group, select the Draw Profiles icon. 
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2) The Draw Profiles dialog is opened. You may notice that it is similar in layout to 
the Draw Cross Sections tool. Set the Job Number to 101 and the chain to our new 
side road chain, WESTOVER. Many items on the dialog will be dimmed out since 
we have not created a GEOPAK profile cell or configured a working alignment for 
this roadway. 

 

3) Zoom out and find a location somewhere below the SR95 profile to place our new 
profile for WESTOVER. If your view is rotated, you will need to un-rotate it. 

Click on the Dialog Profile Cell Control icon near the top of the Draw Profiles 
dialog.  

 

Now we can place a GEOPAK profile cell for our side road. Make settings as shown 
after clicking on the Place Profile Cell icon to the right of the Profile Cell Control 
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dialog. The beginning station is filled in automatically. The value of that station 
depends on where point D201 was located and may vary from what is shown. 

 

Once settings are made move your cursor into the view, the profile cell is on your 
cursor waiting for a data point for placement. Data point somewhere below the 
limits of the SR95 profile cell. 

4) Our profile cell data now appears in the Profile Cell Control dialog. We can dismiss 
this dialog now. 

 
5) In the Draw Profile dialog, we can now set up our surfaces. First, set up the 

existing as shown. 

Use the browse button to set our existing TIN File RO095-01.tin. 

Set Display Settings to By Feature and use the D&C Manager item Exist. 
Ground (found under Exiting Profiles in D&C). Click on the paint brush icon to 
browse the D&C Manager items. 

When settings are made, click the Add button to the right of the surface list area. 
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NOTE:  
In most cases, Void areas are not encountered along profiles but if needed set the 
level and symbology to SURVEY - PROFILE - Ground Line with Text, color 
6, line code 3 and weight 2. 
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6) Now set up the proposed surface for SR95 as shown.  

Use the browse button to set our proposed TIN File SR95proposed.tin. 

Use the D&C Manager item VA Roadway (found under Roadway Vertical 
Alignments in D&C).  

When settings are made, click the Add button. 
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7) You may have noticed that as we added the surfaces they are automatically 
displayed in graphics. Now the Profile Generator tool could be used to develop a 
proposed vertical alignment profile for Westover Drive.  

We did not take the time to set up intersection EOP lines across the side road 
intersection so we can see that the shoulder, curb & sidewalk were included on the 
proposed TIN surface in that area. The Westover Drive proposed vertical alignment 
would need to tie in to the outside edge of the SR95 travel lanes. 

 

NOTE:  
It is not necessary to develop a proposed tin for the mainline to develop side road 
profile tie-ins. We simply used this as an example to demonstrate the Draw Profile 
tool.  

The information needed to tie in to a mainline road: finished grade elevation, cross 
slope and grade on the mainline can all be found using the Shape Analyst tools 
for roadways with superelevation. If the mainline doesn’t have superelevation, then 
the Profile Elevation tool in COGO will provide the information required. 
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8) We will not do anything with the other tabs in the Draw Profile dialog but take a 
moment to look at them. The COGO tab can be used to display profiles for this 
chain which have been developed and stored in the GPK file. 
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9) The Projection tab can be used to project profiles from other chains as well as 
survey chains onto this profile. This portion of the tool is used on bridge replacement 
projects to project existing centerline profiles onto the proposed profile. 

 

10) Anytime data is changed and profiles need to be updated simply open the Draw 
Profile tool and click the Update Profile icon near the top of the dialog. 

 

11) Close the Draw Profile dialog. 
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